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1 Foreword  
 

Thank you for purchasing the Saia PG5® V2.1 package. This file contains descriptions, 
information and tips to help you get the most out of the package. We recommend that you 
review this file before using this new version of PG5. 
 
Saia Burgess Controls has systematically and carefully designed, developed and tested this 
software product in many environments. Saia Burgess Controls has acquired the confidence 
that this product achieves a very high reliability. 
 
As with all other software tools, we recommend the user to regularly save and backup his 
project in order to minimise the risk of losing valuable work. 
 

 

1.1 Standard Disclaimer 
 
 

Neither Saia-Burgess Controls AG nor anyone else who has been involved in the creation, 
production or delivery of the software shall be liable for any direct, indirect, consequential or 
incidental damages (including damages for loss of business profits, business losses, business 
interruption, loss of data and the like) arising out of the use or inability to use the software, or 
any other claim by any part even if Saia-Burgess Controls AG has been advised of the 
possibility of such damages. In the event that Saia-Burgess Controls AG is liable for any 
damages, liability shall be limited to the amount paid for the software under the terms and 
conditions of this agreement. 
 
The use and distribution of Saia PG5 software modules (for example, SComm DLL) with other 
PC applications is generally tolerated by Saia Burgess Controls, even though this use is not 
covered by the PG5 licence agreement. However, Saia Burgess Controls cannot accept any 
responsibility or claims resulting from the use of parts of the PG5 by other PC software 
applications. Should such an application cause any commercial damage or damage to the 
reputation of Saia Burgess Controls, we reserve the right to prohibit the use of PG5 software 
modules by other PC software applications. 

 

1.2 Manuals available on the distribution DVD 
 

 
<DVD drive>:\PG5_InstallationGuide_E.pdf 
 
The installation guide available on the distribution DVD informs you about, the necessary 
computer requirements to install this software. It contains also the description of the 
installation process, the licenses registration and other useful information about the 
installation. 
 
<DVD drive>:\PG5 Suite\Manuals 
 
In order to help you start working with this software package, you will find the main manuals 
on the distribution DVD. 
 
http://www.sbc-support.com 
 
This is the link to Saia Burgess Controls Product Support Website. PCD manuals can be 
viewed online using Acrobat Reader or downloaded and viewed locally. Downloads of service 
packs and PCD firmware upgrades are also available. 
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2 Release PG5 V 2.1.410 

2.1 Installation and compatibility 
 

2.1.1 Minimum computer requirement 

 
PG5 2.1, including Web Editor 8, works under Windows 7 32 and 64 bit, Windows 8 and 
Windows 8.1. 
 
For best performance, we recommend installing PG5 2.1 on a PC with a multi-core CPU 
running at a minimum of 2GHz with a minimum of 2GB RAM (4GB or more is 
recommended). The installation package requires about 600MB of free space on your 
hard disk. 

2.1.2 Prerequisite 

 
As for the PG5 2.1.100, 2.1.200 and 2.1.300, this new version requires the Microsoft .Net 
4.0 Client Profile and Microsoft .Net 4.0 Extended installed on your computer. 
 
For more information about the installation of those components, see the point 5.1.2 
Prerequisite. 
 

2.1.3 Firmware requirement for full PG5 functionality 
 
It's important to use the latest PCD firmware versions for full compatibility with the new 
PG5. The latest COSinus firmware version will be available: 
 

 Into the PG5, in using the PG5 Update Manager (see below), the files are 
available under the following folder: 

 
o For Windows 7, Windows 8 and Windows 8.1:  
 

‘C:\Users\Public\SBC\PG5_21\Firmwares’ 
 

 

 On our support site: http://www.sbc-support.com/ 
 

 On the installation DVD: ‘<DVD drive>:\Firmware Files’ 
 
 

2.1.4 Compatibility with previous versions 

 
Compatibility with PG5 projects version 2.1 
 
PG5 projects made with precedent version of PG5 2.1 are upward compatible with PG5 
V2.1.410, but not back again. Once a project has been opened with the new PG5 V2.1, it 
is not possible to open it again with the previous versions.  
As this new version contains no major changes regarding the project structure and files 
structure, including WebEditor8, we recommend upgrading PG5 2.1 to version 2.1.410. 
 
Compatibility with previous PG5 versions 
 

http://www.sbc-support.com/
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For the compatibilities with the project made with PG5 version older than version 2.1.100, 
please refer to chapter 5.1.4 – Compatibility with previous versions.  

 

2.1.5 User licensing and developer registration 
 

PG5 Licensing 
 
The version 2.1.410 requires a valid PG5 2.1 license key – ‘USER.KEY’. If you already 
get a key for a precedent version of PG5 2.1, this key is still valid with this new version.  
 
If you do not have a valid key for the version 2.1, please refer to chapter 5.1.5 – User 
Licensing and developer registration. 
 
PG5 User Registration 

 
If you get a registration key for the precedent version of PG5 2.1 - ‘REGISTRATION.KEY’, 
this registration key is still valid for this new version. You do not need to register again.  
 
If you do not have a registration key, please refer to chapter 5.1.5 – User Licensing and 
developer registration. 
 

2.1.6 Windows compatibility 

 
PG5 2.1 is compatible with Windows 8, Windows 8.1 and Windows 7 operating systems. 
 
For more information, refer to chapter 5.1.6 – Windows compatibility 
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2.2 General Considerations 
 
The PG5 version 2.1.410 contains new features, enhancements and corrections. This version 
includes an updated version of Web Editor 8. You will find in the following a description of the 
major features and enhancements.  

 

2.3 Support for E-Line programmable devices 
 
 
The new E-Line modules for room automation are free programmable with the Saia PG5. In 
this chapter you will find general information about the configuration and the programming of 
those new modules using PG5. 
 

                 
 

2.3.1 Available E-Line programmable modules 

 

The following programmable E-Line modules are available: 

 PCD1.G3600-C15: E-Line room control module  

With:   
 8 digital inputs 
 4 relays,  
 4 triacs,  
 4 analogue inputs 
 4 analogue outputs 
 1 RS-485 (S-Bus) port and 1 USB port 

 

 PCD1.G3601-C15: E-Line room control module + auxiliary RS-485 

With:   
 8 digital inputs 
 4 relays,  
 4 triacs,  
 4 analogue inputs 
 4 analogue outputs 
 1 RS-485 (S-Bus) port, 1 auxiliary RS-485 port and 1 USB port 

 

 PCD1.G1100-C15: E-Line light & blind module 

With: 
 4 digital inputs 
 2 relays 
 2 analog outputs 
 RS-485 (S-Bus) and USB ports 
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 PCD1.F2611-C15: E-Line DALI module + auxiliary RS-485 

With: 
 for up to 64 DALI ballasts  
 with integrated DALI-Bus power supply (can be deactivated to use an 

external one) 
 4 digital inputs 24 VAC/VDC 
 1 RS-485 (S-Bus) port, 1 auxiliary RS-485 port and 1 USB port 

 

 PCD1.W5300-C15: E-Line analogue module 

With: 
 4 analog inputs  
 4 analog outputs 
 1 RS-485 (S-Bus) port and 1 USB port 

 
For detailed specifications of these modules, please refer to the product catalog or 
datasheets. 

2.3.2 Configuration and programming 

 
These devices can be handled and programmed like a standard PCD.  
 
In order to configure the device, select the corresponding type in the Device Configurator. 
The E-Line modules are defined under the ‘PCD1 E-Line Series’ group in the ‘Change 
Device Type’ dialog. 
 

                               
 
The S-Bus address of the E-Line module can be set by switches or by using the Device 
Configuration. In this case, the switch needs to be set at 99. 
 

                      
 
For an easy installation, you can set the communication parameter ‘Auto-detect Baud 
Rate’ to ‘Yes’. You can download the configuration via the USB connection and then you 
can attach the device to a S-Bus network using the RS-485 port and do the 
commissioning remotely using the gateway of the master PCD.  
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In this case, in the ‘Online Settings’ of the E-Line device, set the ‘PGU’ parameter to ‘No’ 
and enter the S-Bus address of the E-Line device. For the programming, the device can 
be programmed as usual in using the Fupla or IL editors and the build and download can 
be done as a standard PCD. 
 
The access to the input or output is done over media mapping. The direct access using I 
and O media type is not supported. For each module, the input and output media 
mapping is available in the Media Mapping window of the Device Configurator. The media 
addresses are fixed defined from the address 2000 for the flags and for the registers, but 
the symbol names can be changed and adapted. 
 

 
 
Once the device configuration saved, the input and output symbols will be available in the 
‘All Publics’ view in the Symbol Editor and can be directly drag and drop into the Fupla 
connectors or into the IL Editor. 
 

2.3.3 Available resources 

 
In the following, you will find a description of the resources available on the E-Line 
devices and the differences between a PCD standard and the new E-Line modules. 
 
 The following number of blocks and media are available: 

 

 Only COB 0 and XOB 10, XOB 12, XOB 13 and XOB 16 are available. 
 

 100 PB or FB can be defined with a call depth of 8. 
 

 2000 registers, plus 50 allocated for the media mapping of analogue inputs and 
outputs. 
 

 2000 flags, plus 50 allocated for the media mapping of digital inputs and outputs 
 

 200 timers / counters 
 

 50 ROM TEXT/DB 
 

 50 RAM TEXT/DB supported within 5KB of allocated memory. 

 
The following memory space is available: 
 

 64 KB of program data - program info, program code, ROM DB/TEXT, DBX - are 
available in FLASH memory. 
 

 256 bytes reserved in EEPROM for non volatile Registers. 
 

Regarding a standard PCD type, the new E-Line modules have the following restrictions 
and limitations: 
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 All media – registers, flags, timers, counters RAM DB/Text- are in volatile 
memory. No SRAM and no backup are available. 
 

 Sequential programming used in Gaftec is not supported. The programming can 
be done using the IL or Fupla editors. 

 
 SASI for Mode C is available, but without interpreted texts. 

 

 Only IEEE (single) floating point format is supported. 
 

 The media pointer type is not supported. 

 
In case of violations of those limitations, PG5 will generate compilation or build errors. 

 
An important part of the FBoxes available in Fupla is supported on the E-Line platform. 
The following FBox libraries can be used:    

 Binary 

 Blinker 

 Block Control (no SB) 

 Buffers 

 Communication Text (not interpreted) 

 Converter 

 Counter 

 DALI E-Line Driver (new) 

 Data Block 

 Data Buffer 

 EIB Driver (partly) 

 EnOcean (partly) 

 Flip-Flop 

 Floating Point (IEEE only) 

 HVC (partly) 

 Indirect 

 Integer 

 Ladder 

 Move In/Out 

 MP-Bus 

 Regulation (partly) 

 Special, sys Info (partly) 

 Timer 
 
The following FBox are not supported: 
 

 All File System related FBox 
 All HTTP and TCP/IP FBox 
 DDC Suite 
 Dedicated IO FBox (Weight …) 
 Communication FBoxes like Energy, M-Bus, Modem, Room Controller 
 LON 
 BACnet 

 
Specific E-Line FBox libraries will be available in order to setup the E-Line module in an 
easy and efficient way. 
 
Note: Into the Fupla editor, no specific E-Line filtering has been implemented. It means 
that all standard libraries are display and the user has to select by himself only the FBox 
that are supported by E-Line. When placing a non-supported FBox, an error will only 
occurs during the compilation/build. 
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For more information and documentation, please refer to the support web site. 
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2.4 Web Editor 8 
 

 
In this chapter, you will find a description of the new features defined in the Web Editor 8. 
 
DDC Suite templates 
The Web Editor 8 has been updated with the DDC Suite templates version 2.5 in Dutch and 
French. 
 
FTP passive mode 
In the download, for the ‘FTP Server (PCD)’, the passive mode is now supported. 
 

 
 
S-Monitoring templates 
The basic functions of the S-Monitoring application are now integrated as standard templates 
into the Web Editor 8 and are available in the ‘Libraries’ window under the ‘S-Monitoring’ 
group. It is now easier to integrate the S-Monitoring functions into your standard applications. 
 

 
 
Corrections 
Several bug fixes and performance improvements have been implemented in the new version. 
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2.5 Project Manager 
 
In the Project Manager, when creating a new device using the command ‘New Device...’ 
under the menu ‘Device’, it is now possible to directly specify the device type in using the 
‘Device Type’ combo box define in the ‘New Device’ dialog box. 
 

 
 
When the combo box list is open, all available devices are displayed and can directly select. 
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2.6 Device Configurator 
 
 

In this new version, new devices and corrections have been introduced. 
 

2.6.1 Support for new devices 

 
 

The following new devices have been integrated into the Device Configurator: 
 

 E-Line programmable devices - see point 2.3. 
 

 PCD7.D443WT5R: Programmable MircroBrowser Panel, 4.3’’ inches. 
 

 PCD3.M6880:  Dual processor PCD with redundancy support. 
  

For more information and documentation about those new products, please refer to our 
support web site or contact your Saia Burgess Controls sales office. 

 

2.6.2 Selection of property when clicking on error message 

  
In this new version, a double click on a message displayed in the ‘Messages’ window will 
automatically select the slot in the device view and select the related parameter in the 
‘Properties’ window. In the precedent version only the slot was selected. 
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2.7 Fupla 
 

In this chapter, you will find a description of the new features defined in the Saia PG5 Fupla 
Editor. 

2.7.1 Two levels of groups in the template organization 

 
Template can be easily created using the ‘Add Pages to Templates’ context menu and 
place into a template library. In order to create a good template organization inside of a 
library, it was possible to define groups. With this new version, it is possible to define two 
levels of groups, as illustrated in the below picture: 
 

 
 

2.7.2 Text content displayed in online probe 

 
It is now possible to see the first 32 characters of a text in an online probe. Text symbols 
can be added to the side connector and their content can be displayed online in probe. 

 
 
Note: Only the first 32 characters of the text are displayed.  
 
 

2.7.3 Page import/export include symbol tags  
 

The exported pages are containing the symbols used in the page and the TEXT and DB 
content. With this new version, the symbol tags are also exported and imported. 
 

 
 
The tags are displayed and can be modified in the ‘Import’ dialog under the ‘Symbol List’ 
pad.  
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2.8 Symbol Editor 
 

In this chapter, you will find a description of the new features defined in the Saia PG5 Symbol 
Editor. 

2.8.1 Tooltip for DB content 
 

In going over the ‘Address/Value’ field of a DB symbol, the tooltip displays now the first 
five items and their values. 
 

 

2.8.2 Help update 

 
In the help, the information concerning the error and warning message about symbols are 
now accessible directly from the root level. 
 
 
 

2.9 BACnet Configurator and Compiler 
 
 
The following changes have been implemented in the BACnet Configurator and Compiler: 
 
Support for Foreign languages like Russian 
The BACnet Configurator now processes files encoded in UTF8 with BOM (Byte Order Mark) 
or default codepage and save them in UTF8. The BACnet Compiler will process UTF8 
encoded files. 
 
Character set change in BACnet Configurator 
With the BACnet standard 2010, the ANSI encoding becomes UTF8. 
 
Other changes 
Fix some behaviour problems with window position and fix some problems when uploading 
the configuration. 
Add position number in the ‘StringArray’ property view and allow inserting new strings at any 
position. 
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2.10 LON Configuration Editor 
 

In this chapter, you will find a description of the new features defined in the Saia PG5 LON 
Configuration Editor. 

2.10.1 Assign address 

 
The address assigned to the resources of the network variables can be specified in the 
properties window. When array of profiles are used, the value was only specified for the 
first resource address and all others were using the same address. In order to assign 
correctly the address, it was necessary to update manually the generated symbol file. In 
order to have a correct behaviour, a new ‘Offset’ property has been defined for specifying 
the offset for the next resource of the same network variable. 
 

 
 
As in the example above the “analogInput” is an array of 2, it requires one register per 
network variable. The address in the Properties grid is <auto allocated> by default, but it 
can be explicitly specified. It will define the resource of the first array element, to specify 
the other addresses the “Offset” have to be used: each element address will be shifted 
with the specified value. 

 
The addresses are checked when the Create Target button is pressed and in case of 
overlap and error is generated: 
 
Untitled1.lip : Resource is already used R 11 : LONIP.analogOutput_0.nviAnalog.lev_percent - 
LONIP.analogInput_1.nvoAnalog.lev_percen 
 
 

The Assign Address feature also manages the offset value. It count the number of 
resources using the specified media type first and calculate the offset based on that one, 
each selected resource will get the same offset. The generated address map can be seen 
below.  
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2.11 DDC Suite Add-on tool 
 

2.11.1 BACnet update modifications 
 

In the following you will find the changes that affect the way that the ‘BACnet.bnt’ file is 

updated. 

Automatically link BACnet.bnt 

In the PG5 version 2.1.310 the Add-on tool compiled the ‘BACnet.bnt’ file itself. Since the 

Project Manager considered this as a file modification, it asked to build the project again 

(although that had already been done in the Add-on tool).  

In this new version, instead of compiling, the tool just calls ‘Build Changed Files’ in Project 

Manager after the update. At the same time the ‘BACnet.bnt’ file is defined as 

‘Linked/Built’. After running the Add-on tool, the project is ready to download. No further 

steps are needed. 

No reuse of IDs 

The Add-on tool translates the large FBox ids from the ‘DDC_BACnet.bnt’ into smaller in 

the ‘BACnet.bnt’. The translation in the version 2.1.310 was done by assigning the 

smallest free id for a given type. This could however lead to errors in the network when 

BACnet objects were deleted and others added. For example, when removing an ‘AI 5’ 

and adding another AI object, the new one could get the id 5. The network would not know 

that it is another AI. 

In order to prevent the Add-on tool from assigning ids that had already been used, the 

used ids are stored and considered when translating a new object id. The information is 

stored in the ‘DDC_AddOn.ddc’ file in the section ‘NextFreeIds’. The information is only 

reset in the case of an ‘overwrite’ (clear) of the file is performed.  

Prevent DDC Suite FBox update problems 

With the Add-on tool of the PG5 version 2.1.300 there might be problems when the initial 

‘BACnet.bnt’ file was created with the DDC Suite 2.0. If an update is done to DDC Suite 

2.5 then the ‘DDC_BACnet.bnt’ file will contain the new IDs. During the update the Add-on 

tool recognizes that there are existing BACnet objects in the ‘BACnet.bnt’ file but does not 

know their relation with the object in the ‘DDC_BACnet.bnt’ file. A message is displayed 

and it is possible to remove the existing objects or let them unchanged. 

In this new version, the Add-on has been adapted so that a warning is displayed and the 

update can be canceled without modifying the ‘BACnet.bnt’ file. 

Do not re-index program objects (PO) 

The program objects are no longer re-indexed by the tool. Their initial id is carried over 

from the ‘DDC_BACnet.bnt’ file to the ‘BACnet.bnt’ file as is the case for the NC object. 
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2.11.2 Tool modifications 

 
The following points present the modifications related to the DDC Suite add-on tool. 

Blacklist select/unselect all 

The blacklist feature has been introduced in the last PG5 version.  

In order to simplify the work with the blacklist, a ‘Select All’ button and an ‘Unselect All’ 

button have been added in the blacklist window. 

 

Select/Unselect for blacklist 

Backup ‘BACnet.bnt’ 

Each time an update is performed, the ‘BACnet.bnt’ file and the ‘DDC_AddOn.dcc’ file are 

backed up in the ‘Backups’ directory of the project. Only the three last backups are stored, 

older ones are removed. The ‘DDC_AddOn.ddc’ file is also backed up because it contains 

the table where the id translations are defined. Therefore both files (same version) must 

be recovered during restoration.  

The files are automatically restored if the update process fails. Otherwise, the files must 

be recovered manually. 

Menu adaptations & Key shortcuts 

It is now possible to open the log file in using the command ‘Open LogFile’ under the ‘File’ 

menu. It is further possible to open a different device and to access the blacklist through 

the menu bar. In addition key shortcuts allow accessing the most important menu items 

directly. 
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Modified menu bar 

‘Options’ window 

The new ‘Options’ window, accessible with the ‘Options’ command under ‘Tools’ menu,  

allows defining some constants for the update process. It is for example possible to 

deactivate the build step. 

 

Options window 
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2.12 FBox libraries 
 

 
The following FBox libraries have been updated between the version PG5 2.1.300 and 
this new version. Some of them have also been available over the Update Manager. 
 

 Energy Meter Modbus, version 2.7.310 
o FBox H104: modification in ASN verification in order to support Z 

versions. 
 

 File System Library, version 2.7.320 
o Memory Management: new version of the FBox with ‘Lock’ input and 

‘Locked’ output and correction regarding the LED indication with firmware 
up to 1.24.xx. 

o New ‘Copy File’ FBox. 
o Memory Management External: remove compilation warnings and solve 

problem when used together with ‘File Properties’ and ‘Log to file 
advanced’ FBoxes. 
 

 Modem Library, version 2.7.310 
o Correction about the CPU Error flag when sending SMS with Standby 

mode was OFF. 
 

 S-Fup Base, version 2.7.310 
o Improvement in order to support the new programmable E-Line devices. 
o Corrections in FBoxes ‘Saia S-Bus Master’ and ‘Sasi S-Bus Extended’ in 

order to get a successful build when serial channel 3 is set to a Baudrate 
of 115.2 kbps. 
 

 S-Fup Communication, version 2.7.310 
o Corrections in the help of the FBox library. 

 

 S-Fup Analog Module Library, version 2.7.310 
o Internal improvements regarding library’s dependencies. 

 

 DDC Suite 2.5, version 2.8.153 
o Into the ‘Alarming’ family, in FBox ‘Motor 2 speed’ and ‘Motor 3 speed’, if 

BACnet was enabled and e.g. ‘ManSwitch’ not selected, then copy from 
‘PcdInRef’ to ‘PV’ was missing. 

o All FBox with BACnet NC: limits set from -1 to 4194303 (before 4194302). 
o Into the ‘Systems’ family, in the FBox ‘Redundant’: text list contained 

0=daily (element disabled) and 8=daily (element enabled). Fupla was 
displaying an error if daily (8) was selected, element 0 removed.  

o Into the ‘Analog values’ family, in the FBox ‘Sensor’, time delay was not 
working identically like BACnet when limits have changed. 

 

 HDLog, version 2.6.180 
o Correction regarding weekly file recording: when first week of year was 

already in old year, the records in old year also got new year date stamp. 
 

 
The following new FBox library has been integrated into this new version: 
 

 PEHA PHC Library, version 1.0.100 
FBox Library for communication to PEHA PHC Bus based products. It is 
compatible to the PG5 programmable E-Line modules PCD1.F2611-C15 and 
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PCD1.G3601-C15. The library provides a communication driver FBox to 
initialize the serial interface as well as dedicated data communication FBox to 
the PEHA devices ET-B and ET-D. 
 
The library can be used on the following modules: 
PCD1.F2611-C15 
PCD1.G3601-C15 
 
It supports communication to following devices from PEHA 
ET B 2 push buttons  
ET B 4 push buttons 
ET B 8 push buttons 
ET D 8 push buttons with display 
 
More information: 
http://www.peha.de/cms/front_content.php?client=1&lang=2&idcatart=1233&c
atID=406 

 
 

http://www.peha.de/cms/front_content.php?client=1&lang=2&idcatart=1233&catID=406
http://www.peha.de/cms/front_content.php?client=1&lang=2&idcatart=1233&catID=406
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3 Release PG5 V 2.1.300 

3.1 Installation and compatibility 
 

3.1.1 Minimum computer requirement 

 
PG5 2.1, including Web Editor 8, works under Windows XP (SP2), Windows 7 32 and 64 
bit, and Windows 8. 
 
For best performance, we recommend installing PG5 2.1 on a PC with a multi-core CPU 
running at a minimum of 2GHz with a minimum of 2GB RAM (4GB or more is 
recommended). The installation package requires about 600MB of free space on your 
hard disk. 

3.1.2 Prerequisite 

 
As for the PG5 2.1.100, this new version requires the Microsoft .Net 4.0 Client Profile 
and Microsoft .Net 4.0 Extended installed on your computer. 
 
For more information about the installation of those components, see the point 4.1.2 
Prerequisite. 
 

3.1.3 Firmware requirement for full PG5 functionality 
 
It's important to use the latest PCD firmware versions for full compatibility with the new 
PG5. The latest COSinus firmware version will be available: 
 

 Into the PG5, in using the PG5 Update Manager (see below), the files are 
available under the following folder: 

 
o For Windows 7 and Windows 8:  
 

‘C:\Users\Public\SBC\PG5_21\Firmwares’ 
 

o For Windows XP:   
 

‘C:\Documents and Settings\All Users\SBC\PG5_21\Firmwares’ 
 

 On our support site: http://www.sbc-support.com/ 
 

 On the installation DVD: ‘<DVD drive>:\Firmware Files’ 
 
 

3.1.4 Compatibility with previous versions 

 
Compatibility with PG5 projects version 2.1 
 
PG5 projects made with precedent version of PG5 2.1 are upward compatible with PG5 
V2.1.200, but not back again. Once a project has been opened with the new PG5 V2.1, it 
is not possible to open it again with the previous versions.  
As this new version contains no major changes regarding the project structure and files 
structure, including WebEditor8, we recommend upgrading PG5 2.1 to version 2.1.200. 

http://www.sbc-support.com/
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Compatibility with previous PG5 versions 
 
For the compatibilities with the project made with PG5 version older than version 2.1.100, 
please refer to chapter 5.1.4 – Compatibility with previous versions.  

 

3.1.5 User licensing and developer registration 

 
No new license and user registration file are required for this version. But as there are 
new installation folders, key files have to be registered again. 
 
PG5 Licensing 
 
The version 2.1.200 requires a valid PG5 2.1 license key. If you already get a key for a 
precedent version of PG5 2.1, this key is still valid with this new version.  
 
As this new version of PG5 is installed in new folder, the ‘USER.KEY’ file has to be 
registered again, in using the ‘Product Licensing’ command under the ‘Help’ menu 
of the PG5 Project Manager. 
 
If you do not have a valid key for the version 2.1, please refer to chapter 5.1.5 – User 
Licensing and developer registration. 
 
PG5 User Registration 

 
If you get a registration key for the precedent version of PG5 2.1, this registration key is 
still valid for this new version. You do not need to register again.  
 
As this new version of PG5 is installed in new folder, the ‘REGISTRATION.KEY’ file 
has to be registered again, in using the ‘PG5 User Registration’ command under the 
‘Help’ menu of the PG5 Project Manager. 

 
If you do not have a registration key, please refer to chapter 5.1.5 – User Licensing and 
developer registration. 
 

3.1.6 Windows compatibility 

 
PG5 2.1 is compatible with Windows 8, Windows 7, Windows XP operating systems. 
 
For more information, refer to chapter 5.1.6 – Windows compatibility 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 29 of 167 
 

3.2 General Considerations 
 
The PG5 version 2.1.300 contains new features, enhancements and corrections. This version 
includes an updated version of Web Editor 8. You will find in the following a description of the 
major features and enhancements.  

 

3.3 New logo and product name adaptations 
 
 
Following the change of owner, the logo of the company and the product names have been 
adapted. The product Saia PG5® and Saia PCD® are registered trademarks.  
 
This new version of Saia PG5® Suite has been adapted regarding these new names.  
It affects the user interfaces like the application names and about boxes, the installation, 
projects, libraries and settings paths, the help files and the documentation. 
 
The communication package containing the Web Connect, the HTTP Reverse Server, the 
Main Interface, the Web FTP Server and the Web FTP has been renamed to ‘SBC .Net’. 
 

3.3.1 Windows Start menu 

 
In the Windows Start menu, the Saia PG5 and SBC.Net applications are now available under 
the new folder ‘Saia Burgess Controls’.  
 

 
 
 

3.3.2 Installation path – project path 

 
The new default folder for installation path and project is ‘SBC’.  
 
It means that, by default, the setup installs the program files under: 
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Windows 7 and 8: "C:\Program Files (x86)\SBC\PG5 2.1.300" 
 

Windows XP:  "C:\Program Files\SBC\PG5 2.1.300"    
 

PG5 projects, libraries, templates and S-Net files are installed by default under the 
following folders: 
 

Windows 7 and 8: ‘C:\Users\Public\SBC\PG5_21’ 
 

Windows XP:      ‘C:\Documents and Settings\All Users\SBC\PG5_21’ 
 
The configurations for editors are saved under the following folders:  
 

Windows 7 and 8:  ‘C:\Users\<user name>\AppData\Local\SBC\PG5_21’ 
 

Windows XP:    ‘C:\Documents and Settings\<user name>\Local 
Settings\Application   Data\SBC\PG5_21’ 

 
The license’s file (USER.KEY) and the '.5at' files used to register the add-on tools are 
define under in the following folders: 
 

Windows 7 and 8:  ‘C:\Users\Public\SBC\PG5_21\LocalDir’ 
 

Windows XP: ‘C:\Documents and Settings\All 
Users\SBC\PG5_21\LocalDir’ 

 
Some of those folder paths can be modified using the Tools dialog, displayed in using the 
‘Options’ command under the ‘Tools’ menu of the Saia PG5 Project Manager. 
 
 

3.3.3 User specific FBox libraries 

 
If you are using user specific FBox libraries installed in the precedent version of PG5 2.1 
and wanted to use them with this new version, an easy way is to copy the content of the 
‘Usr’ folder from the old to the new folder.  
 
It means:  

 for Windows 7 and 8: 
 

from  ‘C:\Users\Public\Saia-Burgess\PG5_21\Libs\Usr’ 
 
into  ‘C:\Users\Public\SBC\PG5_21\Libs\Usr’ 

 

 for Windows XP: 
 
from  ‘C:\Documents and Settings\All Users\ Saia-Burgess 

\PG5_21\Libs\Usr’ 
 
into  ‘C:\Documents and Settings\All Users\SBC\PG5_21\Libs\Usr’ 

 

3.3.4 Help files 
 
The help files have been adapted regarding the new branding. It includes also the FBox 
and FB libraries help files. It is why this PG5 version contains also new version of 
libraries. See the chapter ‘FBox Libraries’ below for more information. 
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3.3.5 SBC.Net 

 
The package containing the Web Connect, the HTTP Reverse Server (portal), the Main 
Interface, the WebFTPServer and the WebFTP is now called SBC.Net.  
 

 
 
It is accessible using the Windows Start menu under ‘Saia Burgess Controls’ => 
‘SBC.Net’ => ‘SBC.net’. 
 

 
 
The following changes have been introduced: 
 

 The new logo is now visible in the configuration web interface. 
 

 All references to the company and product in the documentation have been 
replaced with the new equivalent Saia Burgess Controls name. 

 

 The HTTP configuration interface API URL’s have changed. The new URL’s are 
exactly the same as the old ones except the path segment prefix who is now 

“SBC.CS”. This only affects external user application that remotely access 

SBC.Net. 
 

 Concerning the communication libraries, all DLL’s namespaces have been 
renamed. Which means that you need to re-import the DLL’s (SBusMaster, 

SBusSlave, LibCgi) and rename the imports prefixes to “SBC.CS”. This affects 

only external user applications that use SBC.Net components as communication 
libraries. 
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3.4 Web Editor 8 
 

In this chapter, you will find a description of the new features that have been implemented in 
the Web Editor 8. 

3.4.1 Default foreground/background view 

 
A view in Web Editor 8 may have a foreground and/or background view. Instead of 
referencing directly a particular view, it is now possible to set the foreground and/or 
background view property of a view to ‘Project Default’. To project’s default foreground 
and background view can be set in the project’s option dialog. The default foreground and 
background view in the projects options can be any view or no view at all. 
 

 
 
Newly created views automatically have the foreground and background view property set 
to ‘Project Default’. 
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3.4.2 Library window enhancements 

 
Library window provides the following new functionality: 
 

 Categories and template metadata can now be edited directly by right clicking a 
template in the library window. 

 

 Templates may be moved from one category into another by drag & drop. 
 

 The context menu allows exporting and importing multiple templates. 
 

 Searching the library is no faster than before. The search result is kept in a tree 
structure. This will help selecting the correct template faster in case multiple 
templates with the same name exist in the library. 

  

 
 
Changing, deleting, reorganizing and exporting templates is only supported for user 
created templates. Templates installed as part of Web Editor are considered as read only. 
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3.4.3 Translation Editor 

 
Web Editor 8.2 moves away from editing translations in CSV files. Instead, translations 
can now be edited from within the newly provided translation editor. New languages can 
be added and removed from within the new editor, the editor allows exporting and 
importing translations to/from CSV files, provides integrated search and allows quickly 
finding unused or missing translations.  
 

 
 
The ‘Show Usages..’ functionality introduced in the last release of Web Editor to show 
variable usages is now also available for translations keys. With this, it is now possible to 
quickly find all the places where a particular translation key is being used. 
Once the project is being built, Web Editor will automatically create the required 
translation CSV files for the visualization runtime. 
 
Existing projects will be migrated semi-automatically when first opened in the new Web 
Editor version. A project migration dialog will pop up for projects that contain translations 
in CSV files. Within this dialog a language can be assigned to every CSV file in the 
project.  
 

 
 
The migration process moves then all translations automatically from the CSV file into the 
corresponding language in the translation editor. Finally the CSV file will be removed (but 
not deleted) from the project. 
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3.5 Device Configurator 
 
 

In this new version, new hardware modules, new export options and a modification concerning 
the user range for analogue modules have been implemented in the Saia PG5 Device 
Configurator. 

 

3.5.1 Support for new IO modules 
 
 

The following new modules have been integrated into the Device Configurator: 
 

 PCD2.W380: 8 channels analogue input module for PCD1.Mxxx0 and  
PCD2.M5xx0, -10V..+10V, -20mA..+20mA, PT1000, Ni1000, 
resistor 2500Ohms or 300 kOhms.  

 

 PCD3.W380:  8 channels analogue input module for PCD3.Mxxx0, 
-10V..+10V, -20mA..+20mA, PT1000, Ni1000, resistor 
2500Ohms or 300 kOhms. 

 

 PCD7.W600: 4 channels analogue output module, 0..10V, pluggable on 
socket A of PCD1.Mxxx0. 

 
 

 PCD2.G200: Multifunction module for PCD1.Mxxx0 and PCD2.M5xx0, 4  
digital inputs, 4 digital outputs, 8 analogue inputs and 8 
analogue outputs. 

 

 PCD7.R610: Micro-SD flash memory card module, support micro-SD flash 
card with up to 1 GByte (PCD7.R-MSD1024). 

 
For more information and documentation about those new products please refer to our 
support web site or contact your Saia Burgess Controls sales office. 

 

3.5.2 IO symbol addresses in Excel export 
 

The Excel export has been modified in order to also export the IO symbol addresses. In 
addition, the symbol comments and tags can now also be included/excluded from the 
export thanks to the new options in the ‘Export to Excel File’ dialog. 
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3.5.3 Default min and max values for analogue inputs and outputs 

 
 
The option “User defined range” is defined for all analogue inputs and outputs. It allows 
definition of user specific minimal and maximal value.  
 
By default, when selecting “User defined range” the minimum and maximum value is now 
set automatically to 0 and 1000. This corresponds to the input or output range of many 
FBoxes. 
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3.6 Fupla 
 

 
In this chapter, you will find a description of the new features defined in the Saia PG5 Fupla 
Editor. 

3.6.1 Page Navigator view: color, separator and groups 

 
The Page Navigator view contains the blocks and their associated pages. Each block can 
contain a lot of pages. For an easier navigation the following new features have been 
implemented in the ‘Page Navigator’ view: 
 
 Page color 
 
The text and background color of the blocks and pages can be specified in the Properties 
window. To specify the color, select the block or page(s) in the ‘Page Navigator’ and set 
the ‘Font Color’ and/or ‘Background Color’ in the ‘Properties’ view. 
   

 
   

Separator 
 
With the new separator object, it is no more necessary to define empty pages for 
separating pages. Separator object can be inserted in selecting the command ‘Insert 
Separator’ from the context menu. When activated, this command will add a separator 
before the selected page. 
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In the tree view, the separator has no icon. The separator text, and the color for the text 
and the background can be adjust in selecting the ‘(Name)’, ‘Font Color’ and ‘Background 
Color’ properties in the ‘Properties’ window.  
 

 
 
Note: The separator is a special page, having his own number. It means that the numbers 
of the “traditional” pages are jumping on each separator. 
 
The separator can be deleted as any other pages using the ‘Delete’ command, from the 
context menu of the ‘Page Navigator’ window.  
 
 Page groups 
 
Another new feature is the possibility to define group in the page tree view. This allows 
regrouping consecutive pages having some common functions. Once define, the group 
can be collapsed or expanded. In oder to define a group, select consecutive pages and 
call the 'Group' command from the context menu. 
 

 
 
The name of the group is automatically created based on the common characters found in 
the page names. Group name can be modified in selecting the group in the tree view and 
editing the ‘(Name)’ property in the ‘Properties’ window. 
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The page groups can be expanded or collapsed by clicking on the icon and in case of 
collapsed groups the group header displays the index of the contained pages.  
 

 
 
Once the group header is selected, It is easy to remove group using the command 
‘’Ungroup’ from the context menu. In using the commands ‘Move Up’ and ‘Move Down’ 
from the context menu, it is possible to move page inside groups.  
 

 
 
A page group use an internal index – page number, it is why the numbers of the 
“traditional” pages are jumping on each group. 
 
Note for FBox developer:  
 
The group ID is used by the compiler to generate a group symbol before the first FBox of 
the page: 
 
__PAGE_ID__ DEF STR "W400Objects" 
 
The symbol can be used in the Fboxes similar way as the Fbox ID. 
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3.6.2 Page import enhancements 

 
Inside the Fupla page ‘Import’ dialog, many parameters can be modified or indexed (for 
multiple import), like the page names and descriptions, the symbol definitions and the 
FBox names, before the insertion of the pages in the Fupla document. 
 
In order to adapt the different parameters in a quick way, a find/replace feature is 
available. The find and replace is specific for each tab – ‘General’, ‘Symbol List’, ‘FBox 
List’ and ‘Adjust Strings’ – and accessible in selecting the ‘Find and Replace …’ command 
from the context menu. 
 

 
 
When the ‘Find and Replace’ dialog is opened, it is possible to switch between the tabs. 
The ‘Find and Replace’ is then atomically adapted regarding the tab and the find and 
replace values are kept. 
 

 
 
 
 
 
 
 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 41 of 167 
 

 
 
In the ‘FBox List’ tab, the ‘FBox Name’, the ‘Reference’ and the ‘Description’ can be 
adapted. When an FBox name has been modified, the references will also be updated in 
the FBoxes having this FBox as reference.  
 
It is not recommended to adapt the ‘Reference’ manually in this table. 
 

 
 
Some BACnet FBoxes are using several adjust string parameters for creating symbol 
names or configuration files. In order to adapt the value of those strings, the new tab 
‘Adjust Strings’ has been added. In this view, the string values can be modified and 
indexed. 
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3.6.3 Delete symbols when a page is deleted 

 
 
When deleting pages or blocks, it is, sometime, useful to not delete the symbols attached 
to the page(s), e.g. when ‘Public’ symbols are used in other pages. 
 
Therefore, the confirmation dialog, displayed before deleting the blocks/pages, has been 
enhanced with the following choices concerning the symbols: 
 

 ‘Keep Public and Local symbols’:  all symbols defined in the deleted pages will 
stay in the Fupla file. 

 

  ‘Remove Local symbols and keep the Public’:  remove only the local symbols 
and keep the Public symbols because they are used in other pages or other Fupla 
files. 

 

  ‘Remove Public and Local symbols’:  all symbols defined in the deleted pages 
will be removed. 
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3.6.4 New features concerning the connectors 

 
 

 Add Input Connectors 
 
The new command ‘Add Input Connectors’, under the ‘Connection’ entry in the FBox 
context menu, creates connectors only in the input side of the FBox. It is also working 
when more than one FBox is selected. 
 

 
  
Select the displayed part of the symbol name 
 
For long symbol names displayed in connector, it is now possible to define which part of 
the symbol name has to be displayed. The parameter ‘Label display’ define in the 
‘Options’ dialog can have the following values:  
 
 
 
 
‘Left..’: 
   
 
 ‘Right..’:    
   
 
‘Left..Right’: 
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3.6.5 Property Window 

 
New style 
 
In order to improve the look and feel of the ‘Properties’ window, a new style is has been 
defined. In this new style, the background color of the description fields is different, the 
online values are displayed in blue, the adjust strings in green. These are the same colors 
as in the ‘Adjust Window’. The buttons for selecting parameter from list are always visible. 
 

 
 
It is possible to reset the standard style in opening the Fupla ‘Options’ dialog, setting the 
‘Adjust style Property grid’ to ‘No’. 
 

 
 
 Tooltip to show the assigned static 
 
The tooltip over the adjust parameter shows the assigned user defined static symbol and 
its address, only after a build. 
 

 
  
 
Collapse All - Expand All 
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New context menu items are available for collapse all or expand all displayed properties. 
 

  
 
 Save expanded state of property categories 
 
The properties grid state is saved based on the displayed object type - FBox, page, block. 
The closed and opened categories are saved and restored the next time the object is 
selected. For the FBoxes, the state of the opened / closed categories is saved for each 
FBox type. 
 
Advanced Info 
 
The ‘Advanced Info’ category has been extended with library distributor information and 
with the FBox ID used for BACnet objects (DDC Suite). 
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3.6.6 Adjust Window 

 
 New style 
 
The ‘Adjust Window’ has also been adapted with the new same look and feel defined for 
the ‘Properties’ view.  
 
The source values are always displayed. The column order can be changed with context 
menu 'Reverse Order'. 
 

 
 

 Tooltip to show the assigned static 
 
As in the ‘Properties’ view, the tooltip shows also the assigned static symbol. 
 

 
 
 
 
Value check when entering values 
 
The modify values are now checked when editing. In case of errors, the cause is 
displayed in the status bar. 
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3.6.7 References view 

 
 The FBox ID, used for BACnet objects in DDC Suite library, is now displayed in the 
‘References’ view. 
 

 
 
The ‘References’ view can be displayed using the ‘Reference Windows’ command from 
the ‘View’ menu. 
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3.6.8 XOB numbers for interrupt inputs 

 
 

Saia PCD devices have interrupt inputs that can call an XOB – exception block. The XOB 
numbers for the interrupt inputs are device specific. For example, interrupt inputs ‘Int0’ 
and ‘Int1’ are available on the PCD3 terminal block. 
  
In Fupla, it is possible to define XOB related to the interrupt input, in using the command 
‘New Block’ => ‘XOB’ => ‘IT: Interrupt input change detected’. 
 

 
 

In order to select the corresponding interrupt input – e.g. Int0 or Int1 for the block, select 
the block in the ‘Page Navigator’,  and in the ‘Properties’ view, you will find the ‘Number’ 
property.  
 

 
 
Then open the ‘System’ tab of the Symbol Editor, select one of the constant define under 
‘S.CPU.Interrupt..XOB’ that match to the desired interrupt input and drag the selected 
symbol and drop it into the ‘Number’ entry in the ‘Properties’ view. 
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3.6.9 Other improvements 

   
 
 

Floating window opacity 
 
When the windows are not docked in Fupla - floating state - then they covers a part of the 
workspace and it is not possible to see what is behind. It is now possible to adjust the 
window opacity with the 'Floating window opacity' parameter define in the ‘Options’ dialog. 
The opacity factor can be adjusted between 1 and 100; lower value makes the window 
more transparent.  
 

 
 
When the window gets the focus, it retrieves his standard state. 
 
Note: The new defined value of this parameter is only valid following a restart from the 

Fupla editor. 
 

 
 
 Popup window delay 
 
In order to maximize the available workspace the docking windows are often unticked, 
only their tabs are visible.  
 

 
 
When a symbol is selected on a connector then the ‘Symbol Editor’ window goes up and 
shows the symbol in the Symbol list. With the new option ‘Popup window delay’ define in 
the ‘Options’ dialog, it is possible to define the popup time for the window, the value is 
specified in seconds, 0 means that the window will not go up. 
 
Note: The new define value of this parameter is only valid following a restart from the 

Fupla editor. 
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Text symbols can be placed in Fupla connectors and content can be displayed 
online using probe 
 
During a page export, only the symbols used on the page are saved into the ‘fxp’ file. By 
adding symbols to the connector it was possible to export symbols also which are not 
directly used on the page, but TEXT symbols were not accepted on the connector.  
 
From now on the TEXT type symbols can be added to the connector and probe can be 
also placed on it, in order to show the first 32 chars of the text content. 
 

 
 
 
 
 Disabled pages do no more generates compilation errors 
 
When a page was disabled, the generated code was not running but was handled by the 
compiler as for any other pages (code generation and collection of the used symbols). 
Often, a page is disabled because it is not finished or contained a missing FBoxes. Now 
the compiler is updated in order to generate only warnings in case of errors on the 
disabled pages. So even if the disabled page contains errors, the project can be build, 
downloaded and started. 
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3.7 Cross-reference extensions 
 

 
The cross-reference function has been extended in order to show the symbol usage in the 
BACnet Configurator, in the Web Editor 8 and in the LON Configuration Editor. 
 

3.7.1 Symbol references in BACnet, Web Editor 8 
 

The ‘Cross-Reference List’ dialog box shows now symbol references in the BACnet 
Configurator and Web Editor 8. You can use the "Goto" command to open these editors 
and select the reference. To find the reference in Web Editor 8, open the Variables page 
(.wvar file) and use its own "Show usages…" command from the context menu. 
 

 
 
 

3.7.2 Symbol references in LON 
 

The Cross-Reference List dialog box shows also symbol references in the Saia PG5 LON 
Configuration Editor. 
 

 
 
The “Goto” command opens the LON Configuration Editor and show the item 
corresponding to the selected symbol. 
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3.8 Library manager : copy used libraries to project 
 
 

 
The new command ‘Copy Used Libraries to Project…’ will copy only the libraries which have 
actually been used by the project into the project's local ".\Libs" subdirectory. The old 
command would copy all libraries with the Library Manager's 'Use' checkbox checked, even if 
the library had not actually be used. The new command ignores the checkbox and only copies 
the libraries which it knows have been used by the project. This saves space by not making 
copies of unwanted libraries. 
 
The list of used FBox libraries is now saved by the new version of the Fupla editor. This 
means that you must open and save each Fupla file using the new Fupla editor so the Library 
Manager knows which libraries have been used. If the used libraries are unknown, warnings 
will be shown in Project Manager's "Messages" window. 
 
This command is available from the Library Manager's context menu or via the "Copy To 
Project >" button. The original command has been renamed to "Copy Checked Libraries To 
Project". 
 
See the Library Manager help for more details. 
 
 

 
 

3.9 Backup files: PG5 version information  
 

 
The suggested file name contains now the PG5 version. The backup file name format is now: 
‘Project <ProjectName>_<PG5 Version>_<Date>_<Time>.zip’. 
 

 
 
In addition, the PG5 version is also automatically displayed under the ‘Comment’ default texts.  
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3.10 Assembler  
 

The assembler has been expanded with new @ operators and directive. Please refer to the 
Instruction List Help document for further details and examples. 
 

3.10.1 New @ operators 

 
The following new @ directives are available: 
 
@STRLEN(string)  

Returns the length of a string. 
 
@ATTR(symbol, GROUP) 

Returns the group name of a symbol. 
 
@ATTR(symbol, SUBGROUP, start, end) 

Returns the subgroup name of a symbol, between the start and end 
subgroups. 

 
@ATTR(symbol, NUMGROUPS) 

Returns the number of groups in a symbol name. 
 
@POW(x, y) 

Returns x to the power of y, where x and y are both integers. 

 

3.10.2 New $FOR … $ENDFOR directive 

 
A new $FOR … $ENDFOR directive allows a piece of code to be repeated (looped) up to 
65536 times.  
 
For example, to clear registers 100 to 109: 
 
    $FOR reg = 0 .. 9 

    LD  R 100 + reg 

        0 

    $ENDFOR 

 
 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 54 of 167 
 

3.11 HTTP Downloader 
 

 
The HTTP Downloader supports extra security parameters: 
 

 ‘Service Key’ as replacement of the FTP/Web Server credentials.  
 

 
 
The ‘Service Key’ property can be define in the Device Configurator, under the ‘Device’ 
slot, in the ‘Options’ category.  
 

 
 

The ‘Service Key’ is also used in the Web Editor 8 download, for downloading web file 
and user access data in a secure way. 

 

 Support portal access credentials (username and password) for the HTTP reverse 
functionality.  

 
 
For the ‘Portal’ usage and settings, please refer to SBC.Net component, under the ‘HTTP 
reverse’ feature. 

 
It is also possible the start the ‘HTTP Download’ from the Saia PG5 Online Configurator, in 
using the ‘Download via HTTP/FTP…’ command under the ‘Online’ menu. In this case, you 
will be free to specify all the settings in dialog, e.g. the program file name and the IP address. 
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3.12 Project Generator 

3.12.1 Import addresses 
 

The new version of the Saia PG5 Project Generator allows importing IO symbol 
addresses. The usage is identical to the existing IO symbol properties: the corresponding 
checkbox has to be checked before doing the selection of the columns.  
 

 
 
Extensions have also been done in the ‘Export’ function of the Device Configurator. 
Please refer to the ‘Device Configurator’ chapter for more information. 
 

3.12.2 Renaming in project files 

 
If an existing device configuration is updated, as much settings as possible (for example 
the IP address) are adopted from the existing device configuration.  
 
In the new version, IO symbol name changes are detected and renamed not only in the 
device configuration but also in the project files, for example in the Fupla files. 
 
This allows changing IO symbol names in Excel in three steps: 
 

 In the Device Configurator, export the existing device configuration to an Excel 
file. 

 Change IO symbol names in Excel. 

 Import the Excel file with the Project Generator in using the update option. 
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3.13 DDC Add-on 
 

3.13.1 Compilation and EDE file creation 
 
The DDC Add-on tool has been extended to be able to compile the BACnet.bnt file and to 
generate the EDE exchange files.  
 
Instead of having to build the entire PG5 project after merging/updating the BACnet.bnt 
file with the DDC Add-on tool, the tool does the BACnet compilation itself. Due to this, the 
project is ready to download after running the Add-on tool.  
 
Equally, the DDC Add-on tool generates the EDE files itself during the update/merge 
process. There is no longer a need to open the BACnet Configurator only to save the 
BACnet.bnt file.  
 
In order to be able to follow all the processed steps, a new window has been added. This 
window displays the update process and the currently performed tasks with eventual 
warnings and errors. 
 

 
 

3.13.2 BACnet object property blacklist 

 
A blacklist for BACnet object properties has been introduced. Thanks this new feature, it 
is possible to ignore selected properties during the update process ‘DDC_BACnet.bnt’ to 
‘BACnet.bnt’. 
 
This can be useful for the case where a configuration is uploaded from a running system. 
This configuration may contain properties that have been set by the management system 
and should not be changed, e.g. ‘weekly-schedule’ property of the ‘Schedule’ object. By 
using the blacklist option such properties can prevented from being overwritten or reset. 
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The blacklist can be edited using the ‘Settings’ link under the ‘Overwrite Properties in 
BACnet.bnt’.  
 

 
 
For each BACnet object, the properties that have to be ignored can be selected. In order 
to reuse blacklists, they can be stored and loaded for other projects/devices. 
 

 
 

3.13.3 Visi.Plus configuration  
 
The DDC Suite 2.5 may generate a ‘DDC_BACnet.dms’ file which contains an incomplete 
database configuration for ViSi.Plus. The new version of the DDC Add-on allows creating 
the ‘<DeviceName>_BACnet.dms’ file containing the completed configuration.  
This process is performed during the update of the ‘BACnet.bnt’ file and does not need 
any further configuration. 
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3.14 LON Configuration Editor 
 
 

In the Saia PG5 LON Configuration Editor, the resources – register or flags - are defined in an 
extra symbol file created using the 'Create Target' command. It will now make the symbol file 
read-only to prevent editing the symbols and loosing the connection symbol - LON object. 
 

 
 
 
 

3.15 MIB File Generator (SNMP) 
 

 
The file containing all the definition required for the PCD media access – 
‘SaiaPCDClassic.mib’ is created by the MIB File Generator and is stored in the 
‘Documentation Files’ folder in the PG5 project directory. 
  
This file and the generated file containing the media access definition - symbol name, type 
and address - must be loaded into the SNMP manager (eg. iReasoning). 
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3.16 FBox Builder 
 

3.16.1 DB item as adjust parameter 
 

In FBoxes containing a lot of configuration parameters, it is useful to map adjust 
parameters directly into DB item in order to reduce the number of registers or flags used 
by the FBox. The FBox Builder and the Fupla have been enhanced for supporting this 
new mapping.  
 
In order to use DB item as adjust parameter, first create a static symbol with RAM DB as 
‘Media’. 
 

 
 
The ‘Count’ must be 1; it specifies the array size, not the DB item number. Then use the 
‘Create ajust parameter’ command for creating the static variable corresponding to the 
adjust parameter. 
 

  
The adjust parameter are connected with the same label as the static variable, in this 
case ‘Store’. 

 
 
In the ‘Field Settings’ dialog, available with the ‘Properties’ command of the context menu, 
the format and the range of the adjust parameter can be specified, as for any other type. 
All types supported by a register or flat type are also supported for a DB item. 
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Define carefully a name in the 'Constant for initialization' field, because this name will be 
the init parameter name for the db item. 
Then select the ‘Index’, it will be the index in the DB elements and cannot be greater than 
the DB size specified at code level. 
  
The DB has to be initialized at the code level, in taking care of: 
 

 The symbol name must be the same as symbol name of the static 
variable, in this case ‘dbSym’. 

 

 The size of the DB must be higher than the highest index used in the 
adjust parameters. 

 

 
 

 
For the initialization of the DB at the code level, any valid expression can be used. 
 
In this case: 
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DB dbSym [100] 0,dbi1,,,dbi4 

 
The init values, in this case ‘dbi1’ and ‘dbi4’ must be listed, separated by comma. For the 
not specified DB item use ‘0’ or empty value (in both case, the item will be initialized with 
0). It is very important that the init values have the same position as defined in the ‘Field 
Settings’ dialog for the adjust parameter. In this sample, it means index 1 for DB item 
‘dbi1’ and index 4 for DB item ‘dbi4’. 
 

 
 

 
 

3.16.2 Insert copy of parameter in Parameter Editor 

 
In the definition of an FBox, when a new parameter has to be created based on an 
existing one, the easiest way is to use the new ‘Insert Copy’ command from the context 
menu in the ‘Parameter Editor’. It works for Input, Output, Dynamic and Static parameter, 
but the most convenient case is to use it for Adjust. It keeps all settings (comments, string 
lists...), and creates the language dependent strings with new IDs. 
 

 
 

3.17 Update Manager 
 

In this new version, the connection to the server has been improved regarding speed and 
reliability. And, in case of connection problem, better errors messages are provided. 

 

3.18 Library Installer: selectable PG5 Version 
 
 

When installing a library, you can now select the target PG5 version instead of just the 
Installation Directory. This makes it easier if you have more than one PG5 version installed. A 
list of all installed PG5 versions is displayed, and you can select the destination version from 
the list. The Installation Directory is also updated when you select a PG5 version. 
 
The active PG5 version, or the version for which the library has been developed, will be 
selected by default. 
 
If you prefer, you can still choose an Installation Directory for the library. Use the radio buttons 
to select which destination will be used. 
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3.19 PG5 Version Selector 
 

 
Users can now have more than one version of PG5 2.x installed. The only restriction is that 
you cannot have two different versions of PG5 2.x open at the same time. (But you can open 
PG5 1.x and 2.x versions simultaneously if you need to.) When Project Manager is opened, it 
updates the registry with information specific to that version, so the add-on tools and other 
applications will know which PG5 version, project, template and library directories (etc) they 
should use. 
 
However, opening Project Manager cannot change Window's "file associations". The file 
associations are normally configured by the PG5 Setup program when the PG5 is installed. 
File associations define which application will be used if the file is opened from Windows. This 
means that if you start the PG5 by opening a Project or Device file (.saai5pj or .saia5pc) from 
Explorer, then it will open it using the last installed PG5 version, not the currently open or last 
used PG5 version. The file associations are also used by the self-downloading files (.saiasdf) 
and library installation files (.saiazip). 
 
When you open Project Manager, you will see a warning in the Messages window if this PG5 
version is not the active version: 
 

 
 
To solve this problem, there is a new PG5 Version Selector application, which you can find in 
the PG5 applications directory: 
 
e.g. "C:\Program Files (x86)\SBC\PG5_21\PG5VersionSelector.exe".  
 
It shows the active version which has the file associations, and a list of all installed PG5 
versions. You can select a new active version and press "Activate". The PG5 Version Selector 
cannot be used if Project Manager is already open, so please close Project Manager first. 
 

 
 
Tip: This application is not accessible from the Start menu because it is not always needed. If 
you will often use this application then you can add a shortcut to it on your Desktop or Task 
Bar. 
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3.20 FBox libraries 
 

 
The following FBox libraries have been updated between the version PG5 2.1.210 and 
this new version. Some of them have also been available over the Update Manager. 
 

 File System, version 2.7.200 
o New ‘Memory Management External’ FBox in order to access the file 

system from different Fupla files. 
 

    
 
o Update help according company and registered product names. 
 

 S-Monitoring, version 1.0.111 
o S-Monitoring HTTP FBoxes – ‘Read Data’ and ‘Read Totals’ – handle 

correctly negative values in range of -1 to 0. 
o Update help regarding new company and product names. 

 

 HTTP Client Library, version 1.0.110 
o Update help regarding new company and product names. 

 

 P-Bus Library, version 2.0.017 
o New ‘Digital output 11Q250’ FBox in order to get the data from the 

compact module PTK1.23V02. 
 

 Belimo MP-Bus Library, version 2.7.300 
o Driver FBox: freeze bit implemented to avoid inter-character gaps. 
o Update help regarding new company and product names. 
 

 DALI Library, version 2.7.300 
o Update help regarding new company and product names. 
 

 DALI F26x Library, version 2.7.300 
o New ‘Send RAW’ FBox to send a standard DALI message to a DALI 

device as raw data (2 bytes). 
o Correction in ‘Edit Scene Level’ FBox: the online values are not correct for 

the display of actual Scene Levels. 
o Correction in the ‘Send Power’ FBox: avoid CPU Error Flag with input 

values less than 1 and option Percent. (Value 0 is not allowed according to 

DALI specification. Lamp must be switched off with an ‘Off’ command.) 
o Update help regarding new company and product names. 
 

 EIB Driver Library, version 2.7.300 
o Update help regarding new company and product names. 
 

 Energy Meter Modbus, version 2.7.300 
o Update help regarding new company and product names. 
 

 Energy Meter S-Bus, version 2.6.191 
o New FBoxes H108S and H108S.PT1000 for the new PCD7.H108S 

module. 
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o Update help regarding new company and product names. 
 

 LON Network library, version 2.7.300 
o Correction in adjust parameter in ‘Send-‘ and ‘Receive HVC Status’ in 

French and German. 
o Update help regarding new company and product names. 
 

 LonIP+FT, version xxx 
o New Lon initialization FBox with output ‘Rdy’ - ready. It’s set when the Lon 

interface becomes operational. 
o Correction in trigger multiple send: ‘Poll’ or ‘Test’ FBox at the same time 

could potentially set the PCD to error Flag.  
o Update help regarding new company and product names. 
 

 RoomController PCD7_L60x-1, version 2.6.522 
o New Light and Sunblind and multi-sensor functionalities to use with 

PCD7.L62xN extension modules and PCD7.L665/6 multi-sensor. 
o New Light 1-4 Room Dimming and Sunblind 1-4 Room continuous 

FBoxes. 
 

 S-Fup Base, version 2.7.300 
o Update help regarding new company and product names. 
 

 S-Fup Communication, version 2.7.300 
o Update help regarding new company and product names. 

 

 S-Fup Analog Module Library, version 2.7.300 
o Update help regarding new company and product names. 

 

 DDC Library, version 2.6.208 
o Correction in ‘System’ -> ‘Time Holiday’ FBox: On/Off dates can be the 

same if switch-on time is earlier that switch-off time. 
o Correction in ‘Controller’ -> ‘Master Cascade’ FBox: cold start value 

wasn’t scaled and produce a wrong output signal for the fist PID loop. 
 

 DDC Suite 2.5, version 2.8.143 
o Correction in ‘Analogue values’ -> ‘Sensor’ FBox: performance limits are 

now as BACnet. 
o Correction in ‘System’ -> ‘Time Holiday’ FBox: On/Off dates can be the 

same if switch-on time is earlier that switch-off time. 
o Correction in ‘System’ -> System heating circuit: a maximum set point of 

150°C is possible. 
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4 Release PG5 V 2.1.200 

4.1 Installation and compatibility 
 

4.1.1 Minimum computer requirement 

 
PG5 2.1, including Web Editor 8, works under Windows XP (SP2), Windows 7 32 and 64 
bit, and Windows 8. 
 
For best performance, we recommend installing PG5 2.1 on a PC with a multi-core CPU 
running at a minimum of 2GHz with a minimum of 2GB RAM (4GB or more is 
recommended). The installation package requires about 600MB of free space on your 
hard disk. 

4.1.2 Prerequisite 

 
As for the PG5 2.1.100, this new version requires the Microsoft .Net 4.0 Client Profile 
and Microsoft .Net 4.0 Extended installed on your computer. 
 
For more information about the installation of those components, see the point 3.1.2 
Prerequisite. 
 

4.1.3 Firmware requirement for full PG5 functionality 
 
It's important to use the latest PCD firmware versions for full compatibility with the new 
PG5. The latest COSinus firmware version will be available: 
 

 Into the PG5, in using the PG5 Update Manager (see below), the files are 
available under the following folder: 

 
o For Windows 7 and Windows 8:  
 

‘C:\Users\Public\Saia-Burgess\PG5_21\Firmwares’ 
 

o For Windows XP:   
 

‘C:\Documents and Settings\All Users\Saia-
Burgess\PG5_21\Firmwares’ 

 

 On our support site: http://www.sbc-support.com/ 
 

 On the installation DVD: ‘<DVD drive>:\Firmware Files’ 
 
 

4.1.4 Compatibility with previous versions 

 
Compatibility with PG5 projects version 2.1 
 
PG5 projects made with precedent version of PG5 2.1 are upward compatible with PG5 
V2.1.200, but not back again. Once a project has been opened with the new PG5 V2.1, it 
is not possible to open it again with the previous versions.  

http://www.sbc-support.com/
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As this new version contains no major changes regarding the project structure and files 
structure, including WebEditor8, we recommend upgrading PG5 2.1 to version 2.1.200. 
 
Compatibility with previous PG5 versions 
 
For the compatibilities with the project made with PG5 version older than version 2.1.100, 
please refer to chapter 5.1.4 – Compatibility with previous versions.  

 

4.1.5 User licensing and developer registration 

 
 

PG5 Licensing 
 
The version 2.1.200 requires a valid PG5 2.1 license key. If you already get a key for a 
precedent version of PG5 2.1, this key is still valid with this new version.  
 
If you do not have a valid key for the version 2.1, please refer to chapter 5.1.5 – User 
Licensing and developer registration. 
 
PG5 User Registration 

 
If you get a registration key for the precedent version of PG5 2.1, this registration key is 
still valid for this new version. You do not need to register again.  
 
If you do not have a registration key, please refer to chapter 5.1.5 – User Licensing and 
developer registration. 
 

4.1.6 Windows compatibility 

 
PG5 2.1 is compatible with Windows 8, Windows 7, Windows XP operating systems. 
 
For more information, refer to chapter 5.1.6 – Windows compatibility 
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4.2 General Considerations 
 
The PG5 version 2.1.200 contains new features, enhancements and corrections. You will find 
in the following a description of the major features and enhancements. 

 

4.3 Device Configurator 
 
 
The Device Configurator has been adapted following the protection rules for PCDs that are 
accessible over Internet. To prevent unwanted access to PCD data and files, default settings 
and password specifications for the Web Server and the FTP Server have been modified. For 
a complete description about the recommended way to connect PCDs over Internet, please 
refer to ‘Connection of PCD controllers directly to Internet’ available in our support web site. 
 
For controlling the access to PCDs connected to an Ethernet network, it is now possible to 
configure the IP filtering feature available in the COSinus version 1.22.  

 
You will find a short description of those adaptations and enhancements in the following. 
 

4.3.1 Adaptations in Web Server configuration 

 
According the new protection rules, the Web Server is disabled by default. It means HTTP 
Direct is disabled for the first and second listener (ports 80 and 81) – see picture below. 
 

 
 
In order to activate the Web Server, the ‘HTTP TCP/IP Port Enabled’ parameter has to set 
to ‘Yes in the ‘HTTP Direct / First Listener’ and ‘HTTP Direct / Second Listener’ 
categories. 
 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 69 of 167 
 

In the ‘Web Server’ category, the property ‘Access Checks Enabled’ is set to ‘Yes’ by 
default in order to control the web server access, in asking for password. When the Web 
Server access check is enabled, a password has to be defined for at least one of the 3 
first security levels: ‘Files Access –‘ , ‘Read CGI Access –‘ or ‘Read/Write CGI Access 
Password’ – see picture below. If not, an error message will be displayed in the 
‘Messages’ window. 
 

 
 
The password can contains any ANSI letters or digits. It must be at least 10 characters 
long, else a warning will be displayed in the ‘Messages’ window. 
 
Note: In order to avoid defining those settings for each new created device, simply set the 
required parameters for your standard applications and save it as a template, using the 
command 'Save as Default' defined under the menu ‘Tools'. The device defined as a 
template will be created automatically when you create a new controller in the Project 
Manager. 
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4.3.2 Adaptations in FTP configuration 

 
According the protection rules, the FTP Server is disabled by default – property ‘FTP 
Server Enabled’ is set to ‘No’ -  and the default user is removed by default – property 
‘Remove Default User’ is set to ‘Yes’. It means that the ‘root’ user will no more give 
access to the PCD file system. 
 

 
 
When FTP Server is enabled, minimum one user name and password has to be defined. 
The user name needs to be minimum 3 characters length. 
 

 
 
The password strength is evaluated depending on the length and mixed between letters 
and digits. For more info about the evaluation please refer to the help. 
 
If the password is not enough complex a warning will be displayed in the ‘Messages’ 
window.  
 
Note: To avoid defining those settings for each new created device, it is possible to define 
a device as template, as explained in the previous chapter. 
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4.3.3 Configuration of IP filtering  

 
 
The new IP access check functionality, implemented in COSinus 1.22, allows filtering of 
incoming IP packets, based on the source IP address. The filtering can be done using two 
different modes: 
 

 White list: All packets are dropped by default and IP addresses in the list are 
accepted. This configuration is the most common setup. 

 

 Black list: All packets are accepted by default and IP addresses in the list are 
dropped. 

 
The configuration parameters are located in the ‘Ethernet’ slot, under the ‘Onboard 
Communications’ category. 
 

 
 
To configure the filtering, first set the ‘Access Control List’ property ‘Show’ in order to 
display the following properties: 
 

 Set the ‘IP Filtering Enabled’ to ‘Yes’ for the PCD to apply the filtering rules. 
 

 ‘IP Filtering Policy’ can be one of ‘White List’ or ‘Black List’. 
 

 To display the ‘IP Filtering List’, press the “…” button after ‘Configure’. 
 
Then the following dialog box is displayed, where the IP addresses and IP address ranges 
can be defined. 
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In this particular example, the PCD will accept any requests on IP address 192.168.10.0 
to 192.168.10.255 and any requests on IP address 192.168.11.1 
All other requests will be rejected. 
 
By bringing up the context menu - right click, you can choose to export the table to a CSV 
file or import in order to replace the contents of the table by the contents of a CSV file. 
 

 
 
It is also possible control the ‘Access Control List’ function using the FBoxes defined in 
the ‘S-Fup Communication library’. See chapter 4.9 ‘FBox Libraries’ for more information. 

 

4.3.4 Easy definition of indexed symbols in Symbol view 

 
In the ‘Media Mapping’ view of the Device Configurator, it is now possible to enter indexed 
symbol names, address and comment using the following syntax: 
 

Temperature0..3 R 200 ;Temperature input 0   

 

Will generates the following symbol definitions: 
 

Temperature0 R 200 ;Temperature input 0   

Temperature1 R 201 ;Temperature input 1   

Temperature2 R 202 ;Temperature input 2   

Temperature3 R 203 ;Temperature input 3  
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It is the same functionality as in the Symbol Editor. It is also possible to give a partial 
definition. For more information, please refer to the help defined under the ‘Media 
Mapping View’ topic defined in the ‘Windows and View’ chapter. 

4.3.5 Export in Excel 
 

From the Device Configurator, it is now possible to export the PCD type, the 
communication, IO and expansion modules to an Excel file. It is also possible to export 
the IO symbols associated to the media mapping of the IO modules. The export 
functionality is accessible over the ‘File’ menu, using the ‘Export’ command. 
 

 
 
 
After an export, it is possible to modify the configuration directly in Excel and then easily 
re-import the configuration into the Device Configurator using the Project Generator, with 
one of the 2 pre-defined templates, see the chapter 4.8 ‘Project Generator’ for more 
information. 

 

4.3.6 PCD3.Mxx60: media mapping for interrupt inputs 
 

Together with the COSinus version 1.22, the interrupt entries, ‘Int0’ and ‘Int1’, available in 
the terminal block of the PCD3.Mxx60 - PCD3 Plus - can now be mapped to flags. A new 
‘Onboard Inputs/Output’ slot has be defined where the media mapping can be configured.  
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4.4 WebEditor 8 
 

The new version of the WebEditor 8 contains some interesting new features and 
functionalities. You will find below a list or the most important points. Beside those points, over 
60 features, wishes and bugs have been implemented and fixed for this new version. 
 

4.4.1 User management 
 
With WebEditor 8.0 every element got a 16 levels access protection with a simple user 
identification template. The new WebEditor version greatly improves this functionality by 
providing a ‘User Editor’ and new login template. 
Within the ‘User Editor’ up to 100 users may be defined. Each user can be member of any 
of the 16 access levels, have its own initial view and language.  
 

 
 
The new login template is simpler to use and more powerful at the same time. Placing it 
on one view is the only thing that has to be done. No further configuration of the template 
is required.  
 

                                        
 
When a user now logs in successfully his Initial View will be shown and the language of 
the visualization changes to the language defined in the ‘User-Editor’. 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 75 of 167 
 

A new zoom command has been implemented where the view will be fit into the ‘View-
Editor’ regardless of the size of the view or the editing area. This command can be 
accessed from the ‘Edit’ => ‘Fit View into Editor’ or by pressing Ctrl + Shift + 0. 

 

4.4.2 Download settings 
 
All Web-Server based download options now allow setting the Web-Server password. 
This enables downloading the project over HTTP to a PCD where its Web-Server is 
password protected. 
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Starting from COSinus 1.22 a much simpler download configuration can be used. Instead 
of providing the Web-Server password, FTP user name and password, it is sufficient to 
provide the Service Key defined in the Device Configurator of PG5. 
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4.4.3 Find usages of functions, conditions PCD and internal 
variables 

 
It is now possible to find all usages of functions, conditions and variables within the whole 
project. This feature can be invoked by right clicking a function, condition or variable in the 
‘Function-‘, ‘Condition-‘, or ‘WVAR-Editor’. The usage information is presented in a 
hierarchical manner.  
 

 
 
 
This allows getting a quick overview where the resource of interest is used. From within 
the ‘Usage Dialog’ one can navigate directly to the element where a resource is used 
simply by clicking the ‘Goto’ button. 
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4.4.4 Renaming variables 

 
PCD and internal variables can be renamed by right clicking the variable in the ‘WVar-
Editor’ window.  
 

 
 
Renaming is a multi step process.  
 

 
 
First, WebEditor will show a dialog where all elements using the selected variable are 
listed.  
 

 
 
Now individual usages may be selected, deselected from the rename operation. This 
allows to renaming only a partition of all usages in the project. As a last step all selected 
usages are renamed within the complete WebEditor project. 
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4.4.5 Keyboard short cuts in View Editor 

 
The keyboard interface in ‘View Editor’ has been enhanced. It is now possible to select 
the next element by pressing the ‘Tabulator’ key. Pressing the ‘Return’ key enters a group 
to edit it and with pressing the ‘Escape' key closes the innermost group. 
 
When one or more view element is selected pressing Return will show an editor for 
changing the default property of the element right in the view editor. The cursor is placed 
in the edit filed so that the value of the property can changed without touching the mouse. 
 

 
 
If more than one element is selected the focus can be switched by pressing the Ctrl-Tab. 
If the default property has more than one possible source type, pressing Ctrl-Up/Down 
can change the type. 

4.4.6 Discrete HDLog trends 

 
The HDLog trending template now supports discrete state trends for each trended curve.  
 

 
 
If a trend curve is drawn in discrete mode the line between two samples will not be drawn 
directly as a diagonal line but only horizontal and vertical lines are used. The trend line 
‘jumps’ from one sample point to the next. 
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4.4.7 More actions 

 
Three new bitwise actions (And, Or, Invert) are now available. New versions of floating 
and integer arithmetic actions have been added. The new versions take two input and one 
destination value, it’s therefore now possible to e.g. add internal variable A, to internal 
variable B and write the result into internal variable C. 
 
 

 
 
 

4.4.8 Bit compare condition operators 

 
Comparing two values can now be done with three new bitwise comparison operators: 
 

 A &= B:  Checks where A ‘bitwise AND’ B is equal to B 

 A &=0 B:  Checks whether A ‘bitwise AND’ B is equal to zero 

 A &≠0 B:  Checks whether A ‘bitwise AND’ B is not equal to zero 
 

With this new conditions operators it is now possible to check whether a particular bit is 
set/unset and perform an action accordingly. 
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4.5 Fupla 
 
In Fupla, the major new feature is the possibility of updating all FBox at a time. In this chapter 
you will find a description of this new feature and some other enhancements. 

4.5.1 Update all FBoxes 

 
Until now, in a Fupla file, it was possible to update the FBoxes only one by one, using the 
'Update' command from FBox context menu. With the new ‘Update FBoxes …’ command 
under the ‘File’ menu, it is possible to update all FBoxes from a file at once. The update 
process contains the following steps: 
 

1) Analyze the Fupla file and fill up a list with all FBoxes that have a newer version. 
2) If required, correct manually some pages in order to make more place for the 

updated FBox. 
3) In the ‘FBox Update List’ view, select the library or libraries that have to be 

updated. 
4) Start the update. 

 
Once the ‘Update FBoxes …’ command selected, the file analysis starts and the following 
dialog box is displayed:  
 

 
 
The analysis goes trough all the blocks and pages and collects the differences between 
the current installed FBox version and the version defined in the Fupla file. A progress bar 
shows the progress and the status show which page is currently analyzed. A ‘Cancel’ 
button is available for stopping the analysis. 
 
Once terminated, the result is displayed in the new ‘FBox Update List’ docking window: 
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The result is displayed in a tree organized in 4 levels: 
 

 Library:    
Root level, only the libraries can be selected to update, in order to 
keep the consistency inside the Fupla file. 

 

 Family:   
FBox family as it is displayed in the ‘FBox Selector’ view. 
 

 FBox:   
FBox Name; the ‘Status’ field lists the changes between the placed 
FBoxes and the new one defined in the library. 
 

 FBox Reference:  
FBox instance in the document; ‘Name’ field contains the position - block 
and page - and the user name. 
 

In some cases, it is not possible to update automatically the FBox. Typical problem is the 
place around the FBox. Using the ’Go to’ command from the context menu of the list or by 
double clicking the FBox reference, it is possible to open the page where the FBox is 
defined and make the adjustments. 
 

 
 
 
Once the update problems manually corrected, the library can be selected and using the 
'Start Update' button, in the top of the ‘FBox Update List’, the update process can be 
started. 
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For more information about this functionality, please refer to the Fupla help, under the 
folder ‘How to …’, in the topic ‘Update FBoxes’. 
 
Note: As the update process can cause major changes in your Fupla file, it is 
recommended to make a backup before starting the update procedure. 
 
Note: In some cases, when the changes are too important for one FBox version to the 
other, the automatic update process is not possible. In this case, the FBox has to be 
manually deleted and replaced with the new one and the adjust parameters have to be re-
entered. 
 

4.5.2 Color Page 

 
In the ‘Page Navigator’ view, it is possible to assign a color for the each page. This is an 
easy way to group page having similar functions defined in it. 
 

                                   
 
The page color can be defined in the ‘Properties’ view. 
 

                             
 
It is possible to define the color for several pages at a time in selecting multiple pages and 
then set the color in the ‘Properties’ view.  
 

4.5.3 FBox ID 

 
In the new DDC suite 2.5 suite, the BACnet configuration is generated from the FBox in 
using a unique FBox ID as link between the FBox and the generated BACnet object. The 
IDs can be visualized directly in the Fupla pages using the ‘Show FBox ID’ command, 
under the ‘Page’ menu. 
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The IDs are displayed in the page in a similar way as the FBox priorities. The ID is also 
displayed in the Properties window of the FBox, under the ‘Advanced Info’ group. It is also 
possible to search for an ID in selecting the ‘ID’ entry in the ‘Find in Document’ dialog. 
 
Note: The FBox ID is unique and cannot be modified by the user. 

 

4.5.4 Connector size increased 

 
In order to display longer symbol names in the Fupla connectors, the limit for the 
connector size has been increased from 20 to 40. 
The connector size can adapted in the ‘Options’ dialog, accessible from the ‘Options..’ 
command under the ‘View’ menu.  
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4.6 Project Manager 
 
 
The Backup and Restore features have been improved for better handling of project 
containing Smart RIO networks, backup/restore of Common Files, and to backup selected 
devices instead of the entire project. 
 

4.6.1 New Backup features 
 
If a backup is made of a single Smart RIO Manager, then all its RIOs are also backed up. 
It is no longer necessary to backup the complete project to include all the RIOs.  
 
If the device uses files in the Common Files directory, these files are now always backed 
up with the device.  
 
A selection of devices can now be backed up. Click on the new ‘Devices…’ button to 
select which devices you want to backup. Any Common Files or RIOs used by the 
selected devices will also be backed up. 
  

 

4.6.2 New Restore features 
 
When the restored device is a Smart RIO Manager, all its RIO devices are now restored.  
 
If the device uses files in the Common Files directory, these are now restored. If the 
Common File already exists, you will be asked if you want to overwrite it. 
 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 86 of 167 
 

  

4.7 Standalone Symbol Editor 
 

4.7.1 Print function 

 
It’s now possible to print the complete symbol list. As in the view the symbols can either 
be printed in a ‘group view’ or a ‘list view’ format. These two modes correspond to the 
possible views of the symbol editor. The group view prints the symbols in a tree of the 
groups. The list view prints the symbols in a table sorted by name. 
 
To print features are accessible in the ‘File’ menu of the Symbols Editor. 
 
The print settings can be defined in the ‘Print Setup’ dialog box.  
 

 
 
Once you have setup your settings the result can be previewed in the new ‘Print Preview’ 
dialog as show bellow. 
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In the Device Configurator and the RIO Configurator, the printing as also been updated 
with some new features like the new ‘Print Preview’ dialog. 
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4.8 Project Generator 
 
 
The first version of the Project Generator, introduce in the first version of PG5 2.1 has been 
enhanced with the following points. 
 

4.8.1 Predefined Templates 
 
In the Project Generator, templates allow a faster import of data without selecting each 
location in the Excel sheet. 
In this new version, the Project Generator contains now predefined templates in order to 
import the device configuration in a faster way in case of generating or updating a project 
from an Excel file generated by:  
 

 The Device Configurator (see point ‘Export in Excel’ under the ‘Device 
Configurator’ chapter). 

 

 The PCD Konfigurator (tools available in Germany). 
 
Instead of going through the entire Wizard, those integrated predefined templates allow 
skipping the cell selection in the Excel worksheets. 
 
The template selection is available in the second page or the wizard: 
 

 
 

 

4.8.2 On-board module I/O symbols 

 
The Project Generator now supports IO symbol import for the onboard IOs as found on 
the following PCD: 
 

 PCD3Compact:  
Slot numbers 0 to 3 have to be specified for the onboard  

   I/Os; slot number 4 for the first slot in the extension module. 

 PCD3WideArea:  
Slot numbers 0 to 3 have to be specified for the onboard  

   I/Os; slot number 4 for the first slot in the extension module. 
 

 PCD1.Mxxx0: 
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The prefix ‘fix 0’ and ‘fix 1’ have to be used for the 2 onboard 
slots and the standard slot number 0 to 1 for the 2 Onboard 
I/O slots 

 
Please refer to the help, under the chapter ‘Rules for Device Configuration’, for more info 
about the import capabilities. 
 
 

4.8.3 Importing multiple Media Mappings 

 
All relevant input/output symbol definitions of modules containing multiple media 
mappings can be assigned, for example the PCD2/3.W525 analogue module.  
 
Note: The Project Generator is not handling the status information mapped to resources, 
available in some analogue or onboard input modules. The Project Generator is only 
importing symbols connected to an input or output value. 
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4.9 FBox libraries 
 

4.9.1 S-Fup Communication: Add IP filter FBoxes and corrections 
 

The FBox communication library has been extended with 2 new FBoxes allowing access 
to the IP filtering functions at runtime. 
 
The ‘ACL IP Open’ FBox allows adding dynamically an IP address to the accepted list. 
This FBox can be used to open an IP address for a Mail server in order to be able to send 
a mail. 

 
 
The ‘ACL IP Filer’ FBox allows switching on or off the IP filter function. 
 
 

 
 
In this library, a correction has been done for the FBoxes S-Bus Send, Binary Quick, 
Integer Quick and Float Quick: during the build, the ‘Symbol is not an array’ error is no 
more displayed when the option "On data change" is used. 
 

4.9.2 New and updated FBox libraries 
 
The following FBox libraries have been updated between the version PG5 2.1.100 and 
this new version. They have also been available over the Update Manager. 
 
 

 SFup Base, version 2.7.200 
o New ‘Summer time’ FBox in System information: this FBox indicates 

winter or summer time using a binary output. 
o Corrections in ‘Off delay with reset’ FBox, outputs ‘time’ and ‘Q’ are no 

more reset if the inputs ‘In’ and ‘R’ are high. 
o Correction in ‘Division’ FBox, the output label ‘B’ is no correctly displayed 

as ‘A%B’. 
o Correction in the ‘IP-Config’ FBox, when DHCP mode is configured. 

 

 SMonitoring, version V1.0.105: 
o This library allows access to the energy consumption data, which are 

located in the S-Monitoring function, part of COSinus. 
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o Improvement and corrections regarding precedent version: 
 Decrease the cycle time peaks at startup while initializing custom 

counters. 
 Shot help is now defined in the Fupla FBox Selector window. 

 

 DDC Suite 2.5, version SP2.8.166: 
o This new library supports the handling of Plant Coding Systems. 
o New Features : 

 Free generation of building ID keys in FBoxes for BACnet and 
alarming. 

 Additional BACnet functionalities. 
 BACnet parameter directly adjustable from the FBox. 
 New FBoxes. 

o Attention : never use DDC Suite 2.0 and DDC Suite 2.5 together in a 
Fupla file. 

 

 DALI F26x, version V2.7.60: 
o This version contains the following features and improvements: 

 Addressing FBoxes, with device filter for service on the fly. 
 Parameter settings for DALI devices. 
 Configuration Manager FBox, with Parameter Upload/Download 

via all devices in the bus. 
 File system FBox for Parameter Backup/Restore. 
 Prepared MicroBrowser web pages. 
 Transmission of all standard DALI commands through addresses, 

groups or broadcast. 
 Single FBox to read DALI status of all devices on the bus 

automatically. 
 FBox for reception of standard DALI commands. 

 
 

 Room Controller PCD7_L60x, version V2.6.484 
o This version contains the following features and improvements: 

 New Master/Slave adjustment possibilities for Light and Sunblind 
FBox. 

 Mode Autonomous/Slave and Master station is individually 
adjustable. 
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5 Release PG5 V 2.1.100 
 

5.1 PG5 2.1 installation and compatibility 
 

5.1.1 Minimum computer requirement 
 

PG5 2.1, including Web Editor 8, works under Windows XP (SP2), Windows 7 32 and 64 
bit, and Windows 8. 
 
For best performance, we recommend installing PG5 2.1 on a PC with a multi-core CPU 
running at a minimum of 2GHz with a minimum of 2GB RAM (4GB or more is 
recommended). The installation package requires about 600MB of free space on your 
hard disk. 
 

5.1.2 Prerequisite 
 
Microsoft .Net 4.0 Client Profile and Microsoft .Net 4.0 Extended must be installed on 
the PC. This can be checked under the ‘Programs and Features’ setting in the ‘Control 
Panel’. 
 

 
 
If not installed, the installation package is available on the installation DVD: 
 
<DVD Drive>:\Windows\ dotNetFx40_Full_x86_x64.exe 
 

5.1.3 Firmware requirement for full PG5 functionality 

 
It's important to use the latest PCD firmware versions for full compatibility with the new 
PG5. The latest COSinus firmware version will be available 
 

 Into the PG5, in using the PG5 Update Manager (see below), the files are 
available under the following folder: 

 
o For Windows 7 and Windows 8:  
 

‘C:\Users\Public\Saia-Burgess\PG5_21\Firmwares’ 
 

o For Windows XP:   
 

‘C:\Documents and Settings\All Users\Saia-
Burgess\PG5_21\Firmwares’ 

 

 On our support site: www.sbc-support.com 
 

 On the installation DVD: ‘<DVD drive>:\Firmware Files’ 
 

www.sbc-support.com
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5.1.4 Compatibility with previous versions 

 
Compatibility with PG5 projects version 2.0 
 
PG5 V2.0 projects are upward compatible with PG5 V2.1, but not back again. Once a 
project has been opened with the new PG5 V2.1, it is not possible to open it again with 
the previous versions.  
 
We recommend to use different project directories for each PG5 version so they do not 
get mixed up. Projects made with the PG5 2.0 must be imported or restored in PG5 
Version 2.1. This makes a new copy of the project and converts the files to the new 
format. The original project stays unchanged 
 
Compatibility with the user FBoxes written for PG5 2.0 
 
The FBox libraries written for PG5 2.0 are fully compatible with PG5 Version 2.1. There is 
no change concerning the FBox definition files, the source files and the help files. 
 
Compatibility with PG5 projects version 1.4   
 
PG5 V1.4 projects are upward compatible with PG5 V2.1, but not back again. Once a 
project has been opened with the new PG5 V2.1, it is not possible to open it again with 
the previous versions (since files are converted to the new format).  
 
We recommend to use different project directories for each PG5 version so they do not 
get mixed up. Projects made with the PG5 1.4 must be imported or restored in PG5 
Version 2.1. This makes a new copy of the project and converts the files to the new 
format. The original project stays unchanged.  
 
Saia Burgess Controls has taken all the necessary precautions to guaranty the 
compatibility between the PG5 projects version 1.4, 2.0 and 2.1. For older projects written 
with PG5 1.3, PG4 or PG3, we strongly recommended to first to update into PG5 1.4 and 
then import into PG5 2.1. 
 
Compatibility with the user FBoxes written for PG5 1.4 or previous versions 
 
The FBox libraries written for PG5 1.4 or old versions have to be update to be used under 
PG5 V2.1.  
 
This update can be supported by the library author or the end user itself. There are 
several ways to perform the update: 
 

 Using the ‘Library Converter’ available in the ‘PG5 Library Manager’. 

 Import an installed library using the ‘FBox Builder’ 

 Open the ‘FBox Builder’ project and convert it to the new version 
 
For more information concerning the update of FBox library, please refers to the help of 
the Library Manager and the help of the FBox Builder. 

 
PG5 compatibility restrictions 

 
There is no compatibility restriction regarding the precedent version of PG5 version 2. 

 
Compatibility with old Windows operating systems 

 
PG5 2.1 is not designed to run under the following operating systems: Windows 95, 98, 
ME and NT, 2000 and Vista. 
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5.1.5 User licensing and developer registration 

 
 

PG5 Licensing 
 
In order to use PG5 version 2.1, a new ‘USER.KEY’ file is needed. The key file from V2.0 
or V1.4 cannot be used. However, you can run V2.1 as a Demonstration version for 90 
days without a key file. The ‘USER.KEY’ file is available from your SBC representative.  
This key file registers your Company and enables the features of the PG5 which are 
needed. Use the Project Manager's Help / Product Licensing command for registering 
the license – ‘USER.KEY’. 
 
 
PG5 User Registration 

 
In PG5 V2.1 we have introduced registration for individual PG5 developers, in addition to 
the existing company registration. When the PG5 first opens, you will be asked to register 
yourself as a PG5 User: 
 
 

          
 
              
A PG5 user is entitled to free software updates, free technical support, and other benefits.  
 
You can skip the registration by pressing ‘Not Now’.  
 
Unregistered users of the PG5 demonstration version must complete the PG5 user 
registration before the PG5 can be used. 
 
It means that PG5 V2.1 with a demo key will not run without having a valid user 
registration. 
 
 Licensed users, with a valid ‘USER.KEY’ file, can skip the developer registration 
indefinitely. 
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To register, click on the link and enter your information on the Saia Burgess Controls 
website:  
            

 
 
You will be assigned a S-Engineer-ID, and a ‘REGISTRATION.KEY’ file will be emailed to 
you. Copy this file somewhere safe on your PC and enter its path on the PG5 User 
Registration dialog box and press ‘Register’. 
 
You can also complete the registration from the Help / PG5 User Registration menu 
command. 
 

5.1.6 Windows compatibility 

 
PG5 2.1 is compatible with Windows 8, Windows 7, Windows XP operating systems. 

 
Directory names 

 
With in PG5 version 2.1, the files are installed in a similar structure as in PG5 2.0. 
 
The PG5 projects, libraries, templates, firmware, and S-Net '.dat' files are installed by 
default in the Public Documents directory. It means:  

 

 For Windows 7 and Windows 8 
C:\Users\Public\Saia-Burgess\PG5_21 

 

 For Windows XP:     
C:\Documents and Settings\All Users\ Saia-Burgess\PG5_21 

 
The specific user settings for the different editors and S-Comm driver are no longer saved 
in the Windows registry but in the directory defined specially for this kind of data: 

  

 For Windows 7 and Windows 8 
C:\Users\<user name>\AppData\Local\Saia-Burgess\PG5_21 
 

 For Windows XP:     
C:\Documents and Settings\<user name>\Local 
Settings\Application Data\Saia-Burgess\PG5_21 
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The license file (USER.KEY) and the '.5at' files used to register the add-on tools are in the 
following directory: 

 

 For Windows 7 and Windows 8 
C:\Users\Public\Saia-Burgess\PG5_21\LocalDir 

 

 For Windows XP:     
C:\Documents and Settings\All Users\ Saia-
Burgess\PG5_21\LocalDir 

 
It is possible to modify (not recommended) the project and libraries paths from the Project 
Manager using the ‘Options’ command under the ‘Tools’ menu. 
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5.2 General Considerations 
 
The main component of this new version of PG5 is the Web Editor 8. This new editor provides 
enhanced experience for developing HMI web projects. 
 
Beside Web Editor 8, the PG5 has been enhanced with new components, like the Update 
Manager, the Project Generator, the HTTP File Transfer and S-Monitoring FBox libraries, with 
new functionalities in existing components, like the Register and Flag extension, the Fupla 
templates, DB import and export, the event based communication in S-Bus communication 
FBox library and with enhancement in existing functions. 
 
You will find in the following a short description of the major changes. 
 
You have to notice that there are no fundamental changes in the base structure of PG5, like 
the assembler, the compiler, the symbol handling, the source file structure and FBox library 
structure. It means that the risks of importing older projects in this new version are reasonably 
low. 

 

5.3 Web Editor 8 
 

Web Editor 8.0 has been completely rewritten with the goal of providing a simpler, yet 
powerful editor to facilitate engineering and maintaining small and big HMI projects in a more 
efficient way. 
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5.3.1 Better project management 

 
This new version provides better project management utilities, which allows better handling of 
bigger projects. Projects can now contain folders hierarchies, to group related Views together; 
images for example are placed automatically in a subdirectory within the project. 
 

                            
 

5.3.2 Unicode 
 
Web Editor starting from version 8.0 is Unicode aware, which means that all foreign 
characters can directly be entered in all editor types of Web Editor. It is no longer necessary 
to use an external tool to edit UTF-8 files. This is also valid for the View editor. No matter what 
character set a language is using, it is no longer necessary to use CSV files if a project is 
using only one language. 
 

5.3.3 Intermediate source file 

 
TEQ files are no longer directly edited in the editor but with an intermediate representation is 
used which will be compiled to TEQ files in the end. This allows the views to become more 
complex but simpler to work with. Those intermediate files are easily handled by source code 
management tools like Git, Subversion or Visual Source Safe.  
 

5.3.4 Hierarchical organization of elements: layers and groups 
 
Views can be composed out of an unlimited amount of layers. Layers can be hidden in 
engineering time to make work on complex views with many overlapping elements.  
Elements may be grouped. Groups themselves can belong to groups etc... Views are no 
longer a flat drawing area but they are a hierarchical organization of layers, groups and other 
view elements. 
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5.3.5 Document outline 

 
The new ‘Document Outline’ window gives an overview of the whole view structure. It allows 
directly selecting elements that are completely covered by others or elements part of groups. 
It is therefore no longer necessary to ungroup grouped elements to edit them. 
 

                                 
 

5.3.6 Elements 

 
Every element on a view and the view itself has name and optionally some descriptive text. 
This helps not to get lost in views containing lots of elements. 
 

                 
 
 The element's description can be included when printing views; it can serve as a simple user 
documentation of the visualization. 
Invisible Elements are no longer cluttering the view in the editor. They have their own place in 
a collapsible area below the editor canvas. 
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5.3.7 Support of many image formats 

 
Many image formats like PNG, JPG, GIF, BMP, etc. are now directly supported in the editor. 
In the editor images can be rescaled and the editor correctly shows transparent images. 
During the build process images will be automatically compiled to the correct GIF format. 
 

5.3.8 Properties view 

 
The old elements configuration dialog is no longer part of the editor. Now the elements 
properties can be edited directly in the dock able ‘Properties’ window.  
 

                           
 
Changing an element’s properties is directly applied to the element in the view editor. This 
gives an immediate feedback of the change. 
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5.3.9 Condition Editor 

  
The look and feel of an element may depend on an unlimited set of conditions. It is now 
possible to compare multiply PCD variables (PPO) or local variables (Container) in one 
condition. The ‘Condition Editor’ makes it easy to edit simple and complex conditions. 
 

 
 
 

5.3.10 Function Editor 

  
In S-Web-Editor 5.x the number of actions that an element could perform was limited. Web 
Editor 8.0 is very powerful in this regard. Actions can now be as complex as required. The 
‘Function Editor’ allows programming actions in a simple table like structure. Besides the 
previous existing functions, many new functions like, add, subtract, multiply, divide, modulo, 
etc. have been added. 
 

 
 
Functions and conditions have (like any element) a name, may have a description and they 
may be reused in multiple element through the whole project. 
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5.3.11 Cross reference 

 
A completely new ‘Cross-Reference’ dialog has been developed. This dialog now shows much 
more sortable and filterable information about the selected items. It also allows changing any 
kind of properties even colors and fonts. 
 

 
 

5.3.12 Libraries window 

 
In the dock able ‘Libraries’ window all templates are immediately available. It is no longer 
required to navigate the file system to find a macro. 
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5.3.13 Symbol window 

 
The ‘Symbols’ window of the attached PLC project is now part of the main application window, 
allowing dragging and dropping symbols to elements properties. 
 

               
 

5.3.14 Powerful search function 
 

The library window, symbol window and cross reference dialog support incremental search to 
quickly find the desired entry.  
 

               
 

5.3.15 Access protection 

 
A new kind of access protection has been introduced where every element can restrict access 
to a mask of 16 user groups.  
 

               
 
This access protection is inherited by child elements of container elements like layers and 
groups. 
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5.3.16 New Embedded View element 

 
With the new Embedded View element complete views can be embedded into other views.  
 

                   
 
With this functionality it is possible to realize simple dialog that can be easily embedded in a 
main view, in adding more comfort and better usability. 
 

                   
 

5.3.17 Integrated build function – Web Builder is no more needed 
 
Building the project is much quicker than it was the case with previous version. The new build 
process is now resolving all symbolic addresses to absolute addresses. This allows a different 
work flow where changes to the visualization no longer require a PLC program download. The 
PCD therefore can stay in Run while the new HMI version is being downloaded. The Web 
Builder function has been integrated in order to support non SBC system and systems having 
no flash memory. 
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5.3.18 Integrated download function 

 
The download experience has been improved greatly. There are now more ways to download 
visualizations. Web Editor 8.0 supports downloading via FTP, Web FTP, USB and even over 
S-Bus using the settings of the configured PG5 device and more. A simple configuration 
mechanism allows precisely defining which files will be downloaded into what directory/flash 
memory module. To do a build and download everything only one button has to be pressed. 
 

 
 
 

5.3.19 Import of old Web Editor 5 projects 
 
Projects from the old Web Editor 5 can be imported and converted to the new Web Editor 8 
format. The import can be done using the following ways: 
 

 Conversion on import or restore PG5 project using the PG5 Project Manager 
(SPM): if during the import or restore, a Web Editor 5 project is detected, then a 
dialog box is displayed asking the user to convert the web project. 

 

 Conversion with the context menu of the PG5 Project Manager (SPM): in the PG5 
project tree, when selecting a Web Editor 5 project file, the command ‘Convert to 
Web Editor 8 project …’ is available on the context menu in order to convert the 
existing web project to the new format. 

 

 Import directly from the Web Editor 8: in the Web Editor 8, use the command 
‘Import Project’ under the menu ‘Project’ > ‘Import’. 

 

 Import from the Web Editor 8 welcome page: on the welcome page, the command 
‘Import S-Web Editor 5.x Project…’ is available. 

 
 
Note: For maintenance or extension of existing projects, the old Web Editor 5 is still installed 
by default with PG5 2.1. 
 
You will find more information in the integrated Web Editor 8 help. 
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5.4 New version of IMaster 
 

In the new PG5 2.1 version, a new IMaster has been integrated. In this chapter, you will find 
the most important modifications. This new IMaster is compatible with Web Editor 5 and the 
new Web Editor 8. 
 
Security Warning with Java engine 1.7 
 
When updating the Java engine from version 1.6 to 1.7 the following message was displayed 
in the browser. 
 

 
 
To solve that problem the Java security settings had to be adapted. 
This is solved now and the new IMaster-Applet runs with the standard security settings. 
 
Digital signature has expired 
 
For the old IMaster 5.15.02 the digital signature expired on the 3

rd
 of January 2013. And the 

following message was displayed: 
 

 
 
If the box "Always trust content of this publisher” has been activated this message was never 
showed again. 
With the new IMaster version 5.15.0219 the signature is renewed. For installations where this 
caused a problem the IMaster must be exchanged. 
 
Parsing problem on first HTML-Tag 
 
The parsing problem on first HTML-Tag when language file (*.csv) was saved as Unicode file 
is now solved. 
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5.5 Update Manager 
 
The Update Manager is providing information about updates or new versions of PG5, FBox 
libraries and firmware versions directly inside PG5. 
 
At each PG5 start, but silently - no visible window, the Update Manager controls if the 
specified interval between update checks is elapsed. If it is the case, an online connection is 
established with the SBC server in order to get the latest updates. A comparison is done 
between your currently installed version and the latest version available on the server. In case 
of updates or new versions, an info is displayed in the status bar of the Project Manager. The 
Update Manager window can then be opened using the ‘Update Manager’ command under 
the ‘Help’ menu or by double clicking on the icon on the status bar. 
 

 
All PG5, FBox libraries and firmware package are listed in the main view.  
 

 
 
When selecting an entry in the list, a short description of the selected component is displayed 
on the right side of the main view. The available new package can be then downloaded and 
installed directly, in using the context menu of the view. It is possible to directly download and 
installed the component using the ‘Update …’ command or only download the component for 
a later installation using the ‘Download …’ command. 
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Archive folder for FBox library installer 
   
For the FBox library, an archive directory has been created in order to save the downloaded 
library version. 
 

 
 
The information about the PG5, FBoxes and firmware version are located in the ‘sbc-
support.ch’ server, in a SQL database. The server application offers a web service in order to 
get the information corresponding to the version installed on the client PC. 
 
New folder for firmware files 
 
The firmware files are now located under the PG5 public folder. You will find the last version of 
the current firmware version, organized in platform types and devices types. 
 

 
 
When downloading a new version of the firmware, the new file is automatically copied into the 
corresponding directory. 
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Options dialog 
 
In order to specify the settings of the Update Manager, an ‘Options’ dialog is accessible when 
clicking on the ‘Option’ text on the top right of the main view. 
 

                    
 
In the ‘Options’ dialog, it is possible to define the following parameters: 
 

 Interval between the check for updates 

 Category of data that has to be displayed in the main view – PG5, FBoxes, 
Firmware 

 Switch to see only the updates or new components 

 Switch to see only the information concerning the FBox libraries that are 
registered in the PG5 user license. 

 Language of the user interface – English, German or French. 
 
            



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 110 of 167 
 

5.6 Project Generator – Excel import 
 
The new PG5 Project Generator is an application that generates or updates a PG5 project 
based on information defined in Excel file. 
 

5.6.1 What kind of data can be imported? 

 
There are mainly 2 categories of data that are available before starting a project and often 
defined in an Excel file.  
 
The first category is the device configuration data, like the device type, the expansion 
modules, the communication modules, the IO modules and also, according the IO 
modules, the IO symbol associated with each IO. All this information can be used in order 
to specify the device configuration, in the same way as using the Device Configurator. 
 
The second category is the symbol information, like the symbol name, the symbol type, 
the symbol address and the symbol comments. The symbol information may be available 
at the project start, given by the planer or the responsible of the SCADA system. 
 
The PG5 Project Generator has been developed in order to easily import those data into a 
PG5 project. 
 
In order to be able the read the info from an Excel file, the data have to be organized in 
columns and defined in the same sheet. 
 
For the device configuration, a column has to be defined for: 
 

 device type and expansion type - required  

 slot number - required  

 IO or communication modules - required 

 IO symbol name - optional 

 IO symbol type - optional 

 IO symbol comment - optional 

 IO symbol tags - optional 
 
In the following picture, on the left there is sample of an Excel file containing device 
configuration information, including the IO media mapping symbols (name, type, 
comments) that can be imported using the Project Generator. On the right, you will find 
the imported configuration, including the imported IO media mapping symbols, defined in 
the ‘Media mapping’ view. 
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For global symbols, a column has to be defined for: 
 

 Symbol name : including groups - required 

 Symbol type: same definition as in the symbol editor (R, F, I, O,…) – optional 

 Symbol address: same definition as in the Symbol Editor – optional 

 Symbol comment: maximum 80 characters – optional 

 Symbol tags: coma separated – optional 
  
In the following there is sample of an Excel file containing global symbol information that 
can be imported using the Project Generator. 
 

 
 
The symbols can be defined into a Fupla file or into a global symbol file and they will 
appear in the PG5 Symbol Editor as ‘Public’ symbols. 
 
For the project and device name:  

 If the PG5 project name and the device name are define in the Excel file, there is 
also a function to import them automatically. 

 
The column order is not relevant and the sheet can contains more information that is 
required for the Device Configuration or for the symbol definition. 
 
If for a device, the device configuration and the global symbols information are available, 
the Project Generator can import them at the same time, independently of the location of 
two different types of data: in two different Excel files, in two different sheets, or into the 
same sheet. 
 
You will find more details about the rules for the data definition in the help of the Project 
Generator. 
 
Note: In Germany, the ‘PCD Konfigurator’, an Excel application for configuring PCDs and 
doing calculation is available. This tool has been updated in order to generate an Excel 
sheet that can be directly imported into PG5 using the Project Generator. Please contact 
our sale office in Germany for more information. 
 

5.6.2 Wizard 

 
The Project Generator is a wizard application that offers the possibility to select and enter 
the data into a sequential way.  
 
As the Project Generator is a standalone application, it as to be started from the Windows 
Start menu, under ‘Saia-Burgess’ then ‘PG5 Suite’ then ‘Project Generator’. 
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Note: under Windows 7, if PG5 is pined into the taskbar, you can start the Project 
Generator directly from the jump list.  
 
At start, a welcome page is displayed, explaining the functionalities and you can press on 
‘Next’ in order to jump to the first step. 
 
As the Project Generator supports the localization, the user interface language can be 
switch between English, German and French. The selected language refers to the 
‘Language for applications’ parameter, defined under the ‘Options’ window of the PG5 
Project Manager. The ‘Options’ windows can be called using the ‘Options …’ command 
under the ‘Tools’ menu of SPM. 
 
The first step is the specification of the Excel file where the device info and / or the symbol 
info are defined. As mentioned before, you can specify file for the device configuration 
only, for the symbol information only of for both. The info can also be present in the same 
Excel file, in this case, just press the ‘Same as above’ button under the global symbols 
selection 
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The second step is the specification of the places where the data are defined, which Excel 
sheet, which cell, which column. 
 
First select the optional entries in the top right of the windows: 
 

 for the device configuration, the IO media mapping symbols data are optional 

 for the global symbols, only the symbol name is required, the other entries are 
optional 

 
Then select the sheet where the infos are defined. And, at the end, specify the location of 
the data into the gird view. For the first data, click on the fist cell that contains the 
information, for the next data selection, the ‘Crtl’ key has to be press and then you have to 
click on the cell containing the desired data. It is possible the restart the selection when 
the ‘Crtl’ key is no more pressed. A description of the different actions is displayed below 
the selection grid, depending on the current selection step. 
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The third step is the specification of the project name and the device name and a first 
overview of the read data and then the PG5 project can be generated. It is then possible 
to specify new or existing project and device name. 
 
In case of existing project, if a new device is specified, a new device, with the specific 
name will be added into the project.  

 
 
For existing device, in case of device configuration data, the existing configuration will be 
replace by the new definition. In case of symbol data, the symbol are added or updated 
into the specified files – Fupla or Global symbols.  

 
In the last step, it is possible to open the generated PG5 project. 
 
In case of errors or warning, a message list is displayed indicating which data is missing, 
wrong or not compatible. Please refer to the help for more information. 

 

5.6.3 Template mechanism 

 
A template mechanism has been implemented in order to speed up the generation of PG5 
project when the structure of the data inside the Excel file is always the defined at the 
same place - same sheet, same cell or same column. In using template, the second step 
– the specification of the places where the data are defined – is done automatically and 
your PG5 project is generated very quickly. 
 
Define new template 
 
Templates can be define in specifying ‘<define a new template>’ inside the ‘Available 
Templates’ combo box in the first step of the wizard. After pressing on the ‘next’ button, a 
view is displayed when the template name has to be defined. It is also possible to enter a 
description of the template. Then the standard selection step can be done. When the data 
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are correctly imported in a PG5 project, on the last page, you have to check the ‘Save the 
new defined template’ check box in order to save the generated template for this import. 
 

 
 
Use template 
 
When importing a second device configuration or/and a global symbol list using the same 
data structure inside the Excel file, just select the name of the already defined template 
inside of the ‘Available Templates’ combo box. 
 
Note: The template has to match together with the data structure, otherwise it will not be 
possible to generate the PG5 project. 
 
Remove template 
 
For removing template, just select the desired template inside the ‘Available Templates’ 
combo box and press the ‘Delete Template’ button. 
 
Re-define template  
 
If you want to re define a template, just select the desired template inside the ‘Available 
Templates’ combo box and then check the ‘Redefine template’ check box. When the data 
are correctly imported in a PG5 project, on the last page, you have to check the ‘Save the 
new defined template’ check box in order to save the generated template for this import. 
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5.7 Fupla 
 

5.7.1 Templates 
 
The Fupla template mechanism has been enhanced with a new organization of the 
templates inside libraries, with the possibility of editing template and backup and restore 
library of templates.  
 
New template organization 
 
The templates are now organized in libraries. The library is the installation unit. It is 
possible to install/update official template libraries, like DDC+, and create new user 
libraries. Inside a library, templates can be organized inside groups. 
 
The template view is displayed inside the Selector window, in selecting the last icon in the 
right bottom corner of the window. 
 

                                                 
 
To create a template from the current Fupla page, use 'Add to Templates...' from the 
context menu of the main Fupla view or form the context menu of the ‘Page Navigator’ 
window. It will create a template in the selected group. If no groups is selected it will 
create the template into the default group 'Group'. 
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The name of the template is created based on the page name; the page description is 
used as template description. If the name already exists it will index the name of the 
template. The group’s and template’s name can be modified using the Properties 
Window: select the template in the ‘Selector’ window in order to see its properties in the 
‘Properties’ window. The templates can be moved also with drag and drop to other groups 
inside the library. 
 

                                               
 
When the group name changed, a new group will automatically be created in the template 
library tree.  
 
When the template property 'Show Import dialog' is disabled, it cannot be customized at 
import, it will add the template to the current file as it was originally defined.  
 
When the template property 'Show Import dialog' is enabled, page name, FBox name and 
symbol names can be modified or indexed.  
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Edit template 
 
In using the ‘Edit Template’ command of the context menu of the template view, it is 
possible to open the template as a standard Fupla file.  
 

                                          
 
The template is open as a new document inside Fupla, only the file extension show the 
difference between a standard Fupla file and a template. 
 

            
 
Once edited, it is possible to add/remove pages, add/remove/update FBoxes, 
add/remove/update symbols, as with a standard Fupla file. 
 
As the same template can be added several times using indexes in the same document, it 
was possible to defined index for pages, FBox names and symbols directly inside the 
‘Import’ template dialog. The names/symbols can be indexed using the character ‘#’ for 
absolute index (base index + current copy) or with $ just referencing to current copy 
number.  
 

                    
 
Example: 

 Number of copies = 2  

 Base index = 3  
 

Defining ‘Page#’ will produce ‘Page3’ and ‘Page4’ 
Defining ‘Page$’ will produce ‘Page1’ and ‘Page2’ 

 
Instead of preparing it every time in the ‘Import’ dialog, the file can be modified before the 
import in editing the template, in using the ‘Edit Template’ command from context menu of 
the ‘Template’ view. 
 
In the template documents, pages, new FBoxes, new symbols can be defined and the 
characters ‘#‘ or ‘$‘ can be defined directly:  
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 In the ‘Symbol Editor’ window for symbols or symbols groups. 

 In the ‘Properties’ window for the page names, FBox names, and references. 
 
 
After editing use the save button on the toolbar or use the 'Update' command under the 
‘File’ menu. 
 
For an easy implementation of the index, the new ‘Find’ and ‘Replace’ functionality can be 
used (see point ‘Find and replace’ below).  
 

 
 
 
Backup and Restore template library 
 
As the templates are grouped into library, a function has been implemented in order to 
easily exchange template libraries between user / computer.  
 
To export a library, select 'Backup Templates Library...' from the context menu of the 
‘Template’ view. A dialog box will be then displayed in order to specify the folder and file 
name of the library backup. 
 

                                
 
 
The template backups are created by default under the ‘Templates’ folder inside the PG5 
User Directory.  
 
In the ‘Backup Templates’ dialog when the ‘Create Install Package’ is checked then it will 
create a read-only library on the computers where it is installed. Use the version number 
to manage the versions. When the package is installed, Fupla checks for the existing 
version and inform when the library already exists. 
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5.7.2 Find and replace 

 
The find / replace functionality has been improved and expanded. It is possible to define 
precisely the element to look in: 
 

 Selection – inside selected items in the current page 

 Current page – active page of the active document 

 Selected pages – selection in the Page Navigator 

 Current file – active document  

 All open files – all opened Fupla document 
 
and the elements to look for: 
 

 for the blocks: name, comment and value 

 for the pages: name, comment and condition editor 

 for the FBoxes: name, reference, comment adjust text  

 for the free texts  

 for the connectors 
 
 
To call the functions use the ‘Find …’ or ‘Replace ...’ command under the ‘Edit’ menu. 
 

                   
 
When the dialog is opened, the 'Look in' detected automatically: 
 

 When FBoxes are selected on the page then 'Selection' will be activated 

 When on the Page Navigator pages are selected then the 'Selected Pages'.  
 
The default entry is 'Current File'.  
 
The 'Find where' checkboxes are unchecked at start-up but keeps the settings after the 
first find action. 
 
Wildcards can be used when the 'Use Wildcards' option is set.  
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When pressing on the ‘Find All’ button, a list of the corresponding objects is displayed in 
the ‘Search Result’ window. When double clicking on the line in the ‘Find Result’ window 
then the corresponding FBox, connector or text is selected on the page corresponding 
page and the property is highlighted in the ‘Properties’ window. 
 
 

 
 
 
Using wildcards 
 
A set of wildcards can be used for search using regular expressions and also to make a 
replace where the result can be also specified using wildcards. In the following there is a 
list of the available wildcards: 
 
?  :  Any single character  

Matches any single character; for example ‘Ne?Symbol’ will find ‘NewSymbol’ 
and also ‘NeoSymbol’. 

 
* :  One or more characters 

Matches zero or more characters; for example ‘new*’ matches any text that 
includes ‘new’, such as ‘newValue’.  

 
Note: Replace is disabled when the string that has to be found contains ‘*’. 
 
[ ] :  Set of characters 

Matches any one of the characters specified in the set; for example 
‘Ne[ow]Symbol’ will find ‘NewSymbol’ and ‘NeoSymbol’ but not ‘NeaSymbol’. 

 
#  :   Any single digit (0 to 9)    

Matches any single digit; for example, ‘5#’ matches numbers that include ‘5’ 
followed by another number, such as ‘51’.  
In the ‘Replace’ function, it specifies the number of digits for the replacement, 
for example with , as ‘Control#Run’ for ‘Find What’ and ‘Control##Run’ as 
‘Replace with’ will convert the index to two digits, ‘Control1Run’ to 
‘Control01Run’. 

 
$  :  Any decimal number    

Matches any number; for example, ‘Symbol$’ matches strings that ends with 
index like ‘Symbol5’ or ‘Symbol1007’.  
Can be also used for ‘Replace’ like ‘Find what’ ‘Control$Run’ and ‘Replace 
with:’ ‘Control####Run’ will convert the any index to four digits 
Control31Run   →   Control0031Run  

 
\ :  Escape 

Matches the character that follows the backslash ‘\’ as a literal. This allows 
you to find the characters used in wildcard notation, such as * and #.  
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() : Expression markers 

The expression inside the brackets will be evaluated first. It can be used for  
‘Find what’:  ‘Control$Run’  ‘Replace with’: ‘Control(####+1)Run’  will convert 
the any index to four digits and increment the index 
Control31Run   →   Control0032Run  

 
Note: the wildcards can be combined within one search string. 
 
Preview Replace Result  
 
For complicated search and replace wildcard strings, it is possible to preview the changes 
in selecting the option ‘Preview replace result at Replace All’. 
 

                                           
 
After pressing on the ‘Find All’ button, the result will be displayed in Find Result window. 
 
             

 
 
To select the items to update, check the box defined in the first row or selects the 
corresponding line and press ‘Space’. When all the items to update are selected call 
context menu and select 'Apply change' or use the button in the toolbar. It will replace the 
texts of the selected items. 
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The ‘Replace’ functionality can be ideally used to update the templates with indexes (see 
point ‘Templates’). 
  

 
 
 

5.7.3 Auto save 
 
 
It is possible to enable an automatic saving of Fupla file using the new property ‘Auto 
Save’ in the ‘Options’ dialog of Fupla, displayed using the ‘Option called by 
'View/Options'.  
 

                                 
 
 
It is possible to enable an automatic backup of the current Fupla file every 2, 5, 10 or 15 
minutes, by defaults the option is enabled and creates a backup every 5 minutes.  
 
The backup file is saved into the PG5 project folder, under the device folder, in the 
‘Backups’ directory. The file is each time overwritten the precedent backup file. 
 
In case of abnormal program termination, the user will be asked automatically if the last 
auto-saved state has to be restored. 
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When the backup file is not restored it will be still available until the next ‘Auto-Save’. 
 
Note: the ‘fup’ file, stored in the backup folder, is still created when the file is saved by the 
user, in order to keep the previous saved state.  

 

5.7.4 Speed improvements 

 
In order to open the Fupla file more quickly, improvements have been implemented in the 
start phase, especially in the load of global symbol information. 
 

5.7.5 Import and export of FBox adjust parameters 
 
With the new command ‘Export FBox Adjust Parameters’ from the context menu of the 
selected FBox, it is possible to export the adjust parameters of an FBox into a text file. 
 

                                      
 

 
The complementary command ‘Import FBox Adjust Parameter’ has also been 
implemented in order to update the FBox adjust parameters from a text file.  
 
Combine with the existing ‘Copy Adjust Parameters’, it is now easy to copy or transfer 
FBox adjust parameters configuration from FBox of the same type between Fupla pages, 
projects or PC.  
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5.7.6 Conditional block 

 
It is now possible to define condition for block in the same way as for the Fupla pages. 
Just select the block in the ‘Page Navigator’ window then, in the ‘Properties’ window, fill 
up   the ‘Condition’ fields. The condition will be check during the compilation and if a block 
is disabled, it will not be downloaded into the PCD and, in online mode, the pages 
inside the disabled blocks will not get an online state. 
 

 
 

5.7.7 Online editing of FBox adjust parameter of Type TEXT RAM 
 
 
In the ‘Adjust Window’, the online values of adjust parameters can be viewed and updated 
in a similar way as in the ‘Watch Window’.  
In order to update an adjust parameter, you only have to specify the new value in the 
‘Modify Value’ column and then  press the ‘→’ button to download the value into the PCD.  
 
This function is now also available for parameters of type TEXT RAM. Such parameter 
can be now safely updated in the PCD in online mode. 
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5.7.8 Show history in Adjust window 

 
When the 'Log Online Changes' functionality is enabled, the changes made online to the 
adjust parameters in the ‘Adjust Window’ are saved into a log file. This function can be 
enabled with the ‘Properties’ command under the ‘File’ menu, then in the ‘Properties’ 
window, set the ‘Log Online Changes’ to ‘Yes’. 
 

                                   
 
 
When this function is turned off – set property ‘Log Online Changes’ to ‘No’ - the changes 
made before are displayed in a list and can be assigned to the source values in order to 
have the same value in the source file as in the PCD.  
 

 
 
The changes can be displayed also for the selected FBox using the ‘History’ button in the 
top right corner to the ‘Adjust Window’.  
 
The selected changes can be applied to the source code, the adjust parameter values will 
be overwritten with the selected values.  
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5.8 Symbol Editor 
 

5.8.1 Import and export DB content from and to CSV file 
 
In the new version of the Symbol Editor, the content of a DB can be stored into a comma 
separated text file.  
 
For a single DB, the CSV file format starts with the index number, separated by a ‘;’ then 
the value of the DB item, a ‘;’ and then the comment. The comment is optional. In the 
following, you will find an example: 
 

                                
 
 
For importing and exporting DB content, the new commands ‘Import …’ and ‘Export ..’ 
have been implemented in the context menu of the ‘DB Edit’ window. 
 

                  
 
By default the CSV file are imported or exported from/to the following directory: 
 

 For Windows 7 and 8: 
 

‘C:\Users\Public\Saia-Burgess\PG5_21\Symbol Editor’ 
 

 For Windows XP: 
 

‘C:\Documents and Settings\All Users\ Saia-Burgess\PG5_21\Symbol Editor’ 
 
The functions ‘Import’ and ‘Export’ are also available in online mode. First you have to 
switch to the edit mode using the ‘Edit Mode’ command in the context menu, then the DB 
content can be modified. In the online mode, the DB size cannot be modified - the DB size 
has to match to the size already define in the source code. When the ‘Edit Mode’ is 
enabled then the values can be also changed by hand and downloaded to into the PCD 
(see point below ‘Upload/Download DB values’). 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 128 of 167 
 

 
 

                 
 
 

5.8.2 Upload and download DB values 

 
In online mode, the modified DB content can be downloaded into the PCD using the 
‘Download’ command defined in the context menu of the ‘DB Edit’ dialog. An ‘Upload’ 
command is also available in order to update the program values with the current values 
define in the PCD.  
 

5.8.3 Rename Public symbol references 
 
When a global symbol is renamed, their references were automatically updated in all 
other source files when a source file was saved.  
 
In order to give a better control to the user, an option is available in order to display the list 
of symbols that have been renamed. The option is ‘Ask before renaming symbol 
references’ and is defined in the ‘Symbol Editor Options’ dialog. This dialog is displayed 
using the Symbol Editor context menu ‘Advanced’, then ‘Options’ command. 
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When this option is selected, when a source file is saved and public symbols have been 
renamed, the dialog box ‘Rename Public Symbol References’. This dialog shows the list 
of symbols with their old name and new name.   
 

                   
 
It is then possible to select the symbol references that have to be renamed in checking 
the box in the first column and then press the ‘Rename’ button. If no symbol reference 
has to be renamed, just press the ‘Don’t Rename’ button. 
 
Note: there is no undo possibility when the renaming of public symbol references is done. 
 

5.8.4 Assigning tags to symbols 
 
Tags are additional information which can be assigned to symbols. Each symbol can have 
one or more tags. The tags can be used for filtering, and in case of symbol export 
functionalities.  
 
Tags can now be assigned to several symbols at a time, in selecting several symbols in 
the grid and then selecting the ‘Assign Tags’ command from the Symbol Editor context 
menu.  
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Then the ‘Tag Edit’ dialog is displayed. 
 

 
 
 
The following states are displayed in the ‘Assigned’ column: 
 

 Checked:    the corresponding tag is defined for all selected symbols. 

 Unchecked:   the corresponding tag is not assigned to any symbol. 

 Intermediate:  the corresponding tag is assigned to only to some of the                                         
    selected symbols. 
 
Just click on the ‘Assigned’ checkbox for changing the tag assignment for all the selected 
symbols. 
 

5.8.5 Possibility to select symbol information when importing 
symbols 

 
There are several cases when only some parts of the existing symbols should be updated 
– for example when addresses assigned by VisiPlus have to be imported back. The new 
option dialog is displayed after the file is selected and allows defining the rules for the 
import: select the fields to update and decide to add new symbols only if necessary.  
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5.9 Flag and register extension 
 
 

From COSinus firmware version 1.20, it is possible to address up to 16384 Flags and 16384 
Registers. Because the PG5 does not know the target PCD's firmware version, you must first 
set the device's Build Option ‘Use 16-bit Register and Flag addressing’ to ‘Yes’: 
 

           
 
With this option set, the PG5 will generate PCD file which uses a new 16-bit instruction 
address format. This PCD file cannot be downloaded or restored to a PCD with older firmware 
which does not support the new format. 
 
Register indirect addressing 
 
With PG5 2.0 and old firmware it was not possible to address Registers above 8191 with the 
Register Indirect instructions. This caused problems with some FBoxes – for example the 
HDLog library - if the media's dynamic address range was above 8191. But now, if 16-bit 
addressing is used, this limitation is removed – all addresses can be used. 
 
Communication Mode C Texts 
 
Register and Flag addresses above 9999 need 5 digits, not 4. This can cause problems with 

communications Mode C texts which contains formatted media address using $Rnnnn and 

$Fnnnn. A new Mode C format has been introduced to indicate that 5 digits will be used - add 

an X after the media code: $RXnnnnn and $FXnnnnn. 

If you have used the standard IL text formatting syntax:  "$", Symbol.04T, then S-Asm – 

the assembler - will automatically add the X and use 5 digits if the address is above 9999, so 
you will not need to modify your existing code. 
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5.10 Download backup file via HTTP 
 

 
In some cases, downloading a PCD user program from a remote location using Ether-S-Bus 
can be problematic. Form one side, the Ether-S-Bus use a special port and open special port 
in IT infrastructure is not always easy. That is why a communication using the standard port 
80 will cause fewer problems. From another side, in case of slow Ethernet communication, 
like VPN or GPRS, Ether-S-Bus is not very efficient because of the short S-Bus telegram. A 
lot of telegrams in a slow network is slowing down the communication. In using the HTTP 
protocol, the telegrams are bigger, but the number of exchanged telegrams is lower. It means 
that the communication speed on slow communication channel can be improved regarding 
Ether-S-Bus. That is why the new download via HTTP has been implemented. 
 
A new command is available in the ‘Online’ menu of the Project Manager: ‘Download via 
HTTP/FTP’. This opens a dialog box where the destination can be configured. Project 
Manager will fill most of the information necessary to perform the download, from the active 
device's configuration. 
 
In some cases, the user will have to enter the user name and password for the FTP 
connection. If “Remember me” is not checked, those values will not be saved and will have to 
be re-entered each time. 
 
The “Refresh button” will attempt to connect to the PCD and read information that will be 
displayed in the group “Connected Device Information” The user must select a valid slot 
before starting the download. 
 
When Start Download is pressed, a backup file is created, and this file is downloaded into the 
selected flash. The PCD then "restores" this backup.  
 
The project must be successfully built before being downloaded via HTTP/FTP. The device 
configuration and web files must be downloaded separately. 
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5.11 Download in Run for PCD1.Mxxx0 and PCD3 + 
 
 
The PCD3+ and PCD1.M2xxx with COSinus firmware 1.20.xxx and above, and all future PCD 
models, have a completely new Download in Run procedure, which is safe and easy to use. 
A new ‘Download in Run’ command can be found on the Project Manager's ‘Online’ menu, 
which opens the new ‘Download in Run’ dialog box: 
 
 

     
 
 
 
This shows a list of all the Changed Blocks since the last download, and indicates if the 
changed program can be downloaded in run. Blocks which can't be downloaded in run are 
shown in red.  
 
It is now possible to download the same program into many different PCDs. The Last 
Downloads list shows which PCDs the program has been downloaded into, using the PCD's 
serial number as identification. It is possible that each PCD contains a different version of the 
program, so selecting the correct PCD in the Last Downloads list will update the Changed 
Blocks list for that PCD. 
 
If no information is available about the last download, you can press the Compare Program 
button. This will upload the existing program (if required) and re-creates the Changed Blocks 
list. 
 
When editing Fupla programs, adding or removing certain FBoxes will disable download in 
run. This is indicated by an icon on Fupla's status bar: green = ok, red = not ok. FBoxes which 
can be downloaded in run are also indicated by their icons in the FBox Selector window. 
 
Refer to Project Manager's help for more details, see Dialog Boxes / Download in Run, and 
Other Topics / Download in Run. 
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5.12 Compare Program 
 

Project Manager has a new ‘Online’ / ‘Compare Program’ command which will compare the 
active device's program with the program inside the connected PCD, and show a list of the 
different blocks and downloadable files. This feature is disabled for old PCD models which do 
not support it. 
 
When the ‘Compare Program’ button is pressed, it connects to the PCD and reads the 
Program Information from the program in the PCD. If information about this downloaded file is 
already available (it has already been uploaded, or a copy of the program was saved when it 
was downloaded), then it compares the latest program file to the copy, and shows a list of the 
differences. If the program file is not available, it is uploaded, and the downloadable files are 
also uploaded, then the compare is done with the uploaded files. 
 
All blocks and files which are different are shown in the ‘Changed Blocks’ list. Blocks shown 
in red cannot be downloaded in run. 
 
The ‘Program Information’ button is a short-cut to display the Program Information of the 
active device's program, and the program in the connected PCD. 
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5.13 Smart RIO Configurator 
 
 

5.13.1 Download changed RIO files 

 
The Project Manager has a new ‘Online’ / ‘Download Changed RIO Files’ menu 
command which is shown if the active device is a smart RIO manager. This feature shows 
a list of all the changed RIO files, and allows then to be downloaded into the manager 
while the process continues to run. 
 
To determine which RIO files have changed, first press the ‘Check For Changes’ button. 
This uploads the program information from each RIO file in the manager PCD, and 
compares it with the program information of the RIO files in the PG5 project. The changed 
RIO files list is filled with the RIO files which are different.  
 
The list shows the RIO name, IP address, program version number (from the Device 
Properties) and the build date from the PG5's RIO program on the PC and the RIO 
program currently in the PCD. 
 
Select the RIO files to be downloaded with the checkboxes; all are checked by default. 
Press ‘Start Download’ to download the selected RIO files into the manager PCD. The 
download is done without stopping the manager. Once all the changed RIO files have 
been downloaded, the manager will automatically transfers the new files into the RIOs.  
 

 
 

5.13.2 Localization 
 
The Smart RIO Configurator user interface can now be in English, French or German. The 
language is selected from Project Manager's ‘Options’ dialog box using ‘Preferred 
language for Applications’. 
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5.14 Reset Window Layouts 
 
The new command ‘Reset Window Layouts’ is defined under the ‘Tools’ menu. 
 
In some cases, if the screen resolution or number of displays has been changed, the docking 
windows or resizable dialog boxes may be incorrectly displayed or may be hidden. This 
feature resets the positions back to the defaults. 
 
When selecting this new command, the ‘Reset Window Layouts’ dialog is displayed and you 
have to possibility to select the different layouts that have to be reset.  
 
The ‘All’ checkbox sets or clears all the checkboxes. The ‘Dialog box sizes and positions’ 
checkbox resets all the PG5's resizable dialog boxes, such as the Program Information dialog. 
It works for all applications. The ‘Docking Window Layouts’ checkboxes resets the docking 
window layouts of the selected applications. The application must not be open.  
 
Resetting Project Manager's layout has no effect until the Project Manager is closed and re-
opened. 
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5.15 Device Configurator 
 

5.15.1 New devices 
 
The following devices have been integrated into the Device Configurator: 
 

 PCD7.D457VT5F: 5.7’’ programmable panel 

 PCD7.D410VT5F: 10’’ programmable panel 

 PCD7.D412DT5F: 12’’ programmable panel 

 PCD3.M6860:  controller with 2 Ethernet interfaces 

 PCD1.M0160E0:  e-controller 

 PCD1.M2110R1 room controller 

 PCD1.M2160: PCD1 controller 
 
 

5.15.2 New communication modules 

 
The new advanced communication modules PCD2.F2150 and PCD3.F215 supporting 
BACnet MSTP have been implemented. All communication parameters can be defined 
using the property grid, see below the point ‘BACnet Configurator’ for more info. 
 
The new LON TP/FT-10 communication modules PCD2.F2400 and PCD3.F240 have 
been implemented. 
 

5.15.3 Support for Ni 1000 L&S temperature sensor 
 
 
The support of the Ni 1000 L&S temperature sensor has been implemented in the new 
COSinus version 1.20.  
 

 
 
It is now possible to configure Ni 1000 L&S as input range for the modules: 
 

 PCD2.W220   -   PCD3.W220 

 PCD2.W340   -   PCD3.W340 

 PCD2.W525   -   PCD3.W525 

 PCD2.W745   -   PCD3.W745 
 
Note: The support for Ni 1000 L&S was already available on the onboard analogue inputs 
of the PCD1.Mxxx0, PCD3 compact and PCD3 WAC. 



Saia-Burgess Controls AG                                              What’s New in PG5 2.1 
 
 

Page 138 of 167 
 

5.15.4 Monitoring and logging of meter data 

 
On PCD1.M0160E0, PCD1.M2160, PCD3.Mxx60 (PCD3+) and PCD7.D4xx 
programmable panels, the monitoring and logging of meter data has been implemented 
together with the COSinus version 1.20. 
 
This function allows the automatic monitoring and logging of energy data coming from 
meters, like S-Bus energy meters and data coming from gateways, like the H104 
interface. 
 
This functionality can be enabled in selecting the ‘Monitoring’ slot and activating the 
‘Monitoring Enabled’ property. 
 

 
 
Once the monitoring function enable, it is possible to activate an RS-485 onboard 
interface in order to automatically detect the S-Bus energy meters or gateways and start 
the data acquisition and logging. 
 

 
 
The S-Monitoring FBox library and web projects templates are available to manage and 
display the logged data from the user program side. Please refer to our support site for 
more information. 
 

5.15.5 Upload device configuration 
 
The upload of the device configuration has been modified in order to improve the handling 
of the IO settings and media mapping. 
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In the new version there are two possible way of uploading the IO settings and media 
mapping: 
 

 Upload the IO settings and media mapping 
 

The upload process reads the IO handling configuration currently defined in 
the connected device. If IO handling is already defined in the device, the 
entire module configuration will be retrieved: the module type, the slot where 
the module has been set, the module properties and the definition of the 
media mapping. If the media address is specified inside of the dynamic range, 
the address will not be displayed (let the address dynamically addressed). If 
the media address is specified outside of the dynamic range, the address will 
be displayed. 
If no IO settings information are found into the connected device, a message 
box will be displayed at the end of the upload to ask if the current IO settings 
has to be kept, if the uploaded device is compatible with the defined IO 
modules and expansion. 

 

 Keep the current defined IO settings and media mapping 
 

The current defined IO settings and media mapping will be kept into the 
current uploaded hardware settings. It is not always possible to keep the 
current IO configuration because the uploaded device type is different than 
the current device type defined and the IO module will not be always 
compatible, for example when switching from a PCD2 to a PCD3 type, when 
switching from an PCD type that allows extension to a PCD type which has 
no extension slot. In this case, the upload process will not read the IO 
handling configuration currently defined in the connected device. 

 
Note: Using the ‘Undo’ command from the ‘Edit’ menu, it is always possible to retrieve the 
configuration defined before the download. 
 
 

5.15.6 Localization 
 

The specification of the user interface language is not more define in the Device 
Configurator options.  
 
As for other PG5 applications – Smart RIO Configurator, Project Generator, DDC add-on, 
the language is selected from Project Manager's ‘Options’ dialog box using ‘Preferred 
language for Applications’. 
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5.16 SD File System Explorer 
 
 
In the new firmware – COSinus version 1.20, the file system has been extended in order to 
give information about date/time of creation and modification of files. 
 
According to this modification, the SD File System Explorer has been extended in order to 
handle the new file system format. 
 
The version of the file system is determined automatically and the view adjusted when reading 
the information from a SD Flash card. 
 

 
 
In using the SD File System Explorer, it is possible the update the file system version in re-
formatting the file system defined in the SD card. 
 
In the ‘Options’ dialog, available form the ‘Options’ menu of the main view, the desired version  
- New or Old – can be specified, after re-formatting. 
 

                    
 
The formatting operation will destroy all the data on the file system. 
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In order to preserve the data, first perform a backup of your files using the ‘Backup …’ 
command under the ‘File’ menu, then after formatting – ‘Format’ command, you can restore 
the original data using the ‘Restore …’ command. 
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5.17 BACnet Configurator 
 
 
In the BACnet Configurator, modifications have been implemented for the configuration of the 
DataLink. It is now recommended to use only the Device Configuration for defining the 
communication settings. In the following, you will find more information about those changes. 
 
 
DataLink configuration 
 
The Data link should be configured only once. If it is defined in the Device Configurator and in 
the BACnet Configurator, a warning message will be displayed by the compiler and the 
Device Configurator settings will be used. 
 

                 
 
 
 
IP settings 
 
The IP communication parameters can be configured in the Device Configurator, by adding a 
PCD7.R56x module to one of the memory slots and configuring the BACnet IP setting using 
the ‘Properties’ window. 
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The following BACnet memory modules are available for the memory slots: 
 

 PCD7.R560 

 PCD7.R561 

 PCD7.R562 
 
The following BACnet memory modules are available for the onboard I/O slots: 
 

 PCD3.R560 

 PCD3.R561 

 PCD3.R562 
 
 
MSTP settings 
 
The MSTP communication protocol can be configured by adding BACnet compatible F215 
modules into the onboard I/O slot and a PCD7.R56x module to a memory slot (see above). 
 
 

 
 
 
The BACnet MSTP modules PCD3.F215 are available for PCD3 devices and modules 
PCD2.F2150 for PCD1 and PCD2 devices. 
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5.18 LON Configurator 
 
 
A brand new LON Configurator has been integrated in this version. It supports configuration of 
LON / IP and LON TP/FT-10. 
 
New workflow 
 
In the previous editor version, the standard profiles have to be opened in the ‘Profiles Editor’ 
and then only from there it was possible to add this profile to the target configuration. 
 
Within the new editor version, the profiles can be edited separately. It means that standard 
and user profiles can be used in the same way: just drag and drop the selected item from the 
selector view into the configuration and the profile is assigned.   
 
New user interface 
 
According to the new workflow, the LON Configurator user interface has been re-designed for 
giving a better handling to the user and similar look and feel as the other PG5 applications. 
 
The new multi-document interface lets the user to edit multiple configurations at the same 
time; the documents are tabbed windows, as main view of the LON Configurator.  
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User interface elements 
 
Main view 
 
The Main view contains the current configuration of the node, with the overview of all network 
variables, the type, the array size, the index, the format and the PG5 symbol names. 
 
Selector window  
 
With the context sensitive content, it is possible to handle the standard and user defined 
profiles in the same way.  
 

 
 

 ‘Standard’: contains the LonWorks standard profiles 

 ‘Device’: contains the user defined profile for the current device 

 ‘User’: defined profiles can be shared and moved to the User folder, so all  
project can use the same profile.  

 ‘Custom’: can contain any other profile list file.  
 
Properties window 
 
The ‘Properties’ window shows the specific settings of the selected item. It lets only to edit the 
parts that can be modified. This window is also used for editing profiles and target 
configuration, and makes possible to review all settings of the configuration file. 
 
Output window 
 
The Output window shows the events generated during the configuration or the generation of 
the output files, like the PG5 symbol files. 
 
Error List window 
 
The Output window shows the messages generated during the configuration or the generation 
of the output files, like the PG5 symbol files. 
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Improved Symbol handling 
 
The symbol names assigned to the resources can be checked during editing time, in the new 
grid. The associated symbol file, generated when saving the configuration, can be easily open 
from the toolbar. It is also possible to assign user defined address to the symbols. 
 

 
 
 

 
 
 
Online capabilities 
 
It is possible to go online with the LON Configurator, in selecting the ‘Go Online’ command 
under the ‘Device’ menu. 
 

                                     
 
In this mode, the online values of the assigned resources (fags, registers…) are displayed in 
the main view. The values are displayed based on the format of the resource.  
 

 
 
 
The selected resource can be added to the Watch Window in order to modify the value and 
download it into the PCD.  
 
 
 
Support for TP/FT-10 
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Up to four LON TP/FT-10 interface modules can be defined into a PCD device. When defined 
in the Device Configurator, the communication port will automatically be updated depending 
on the slot where the module is defined.  

 
 
 
In the LON Configurator, the port number has to be defined when selecting the first entry in 
the configuration tree and enter the port number into the ‘Port’ property in the ‘Properties’ 
window. The port number is the link for downloading the configuration into the corresponding 
LON communication module. 
 
 

 
 
 
Associated to the LON Configurator, a new LON Compiler is available for creating the 
downloadable files. The symbols (flags, registers…) are generated in the same way as for 
LON IP configurations.  More detailed error or warning messages are now generated and the 
errors are marked in red in the main view. 
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5.19 MIB File Generator for SNMP 
 
 
Simple Network Management Protocol (SNMP) is an Internet-standard protocol for managing 
devices on IP networks. As the PCDs have an integrated SNMP function, an SNMP manager 
can access the PCD resources – flags, registers …, like a SCADA system. 
 
For accessing the PCD resources, the SNMP manager has to know the type and address of 
the resource. In using MIB files – standard resource description file used by SNMP manager, 
it is possible to access directly the resources using their symbol name defined in the 
corresponding device inside a PG5 project. 
 
For generating an MIB file for a specific device, you have to add a new ‘MIB Symbol File 
Generator’ file in the ‘Program Files’ directory of the PG5 Project Manager. Then the following 
dialog will be displayed. 
 
 

  
 
 
By default, the MIB File Generator is exporting all public symbols. To limit the choice you can 
tag the symbols using the Symbol Editor and export only the tagged symbol into the MIB file. 
You just have to specify one or more tag name in the dialog. By default, no tag name is given; 
it means that all ‘Public’ symbols will be defined in the MIB file. 
 
The MIB file containing the symbol definitions is generated automatically after each successful 
build. There are some limitation concerning the symbol types that can be exported and it can 
produce warning message during the build, indicating the symbol who doesn’t have been 
included into the MIB file. 
 
The resulting file, with extension ‘.mib’ is generated in the ‘Doc’ directory, under the device 
folder of the PG5 project, and will look like this: 
 
 

Bacnet-BTF-Project DEFINITIONS ::= BEGIN 

  IMPORTS 

  MODULE-IDENTITY 

    FROM SNMPv2-SMI 

      regValueInt, regValueUInt, regValueSInt, 

      regValueUSInt, regValueBInt, regValueUBInt, 

      dbValueInt, dbValueUInt, timerValue, counterValue, 

      ioValue, flagValue, textValue 

    FROM SaiaPCDClassic 

      sbc-ag 

    FROM SaiaPCDClassic; 

 

  saiapcdclassicsymbolmibV2ModIdentDefault MODULE-IDENTITY 

    LAST-UPDATED        "201210170958Z" 

    ORGANIZATION        "Saia Burgess Controls" 
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    CONTACT-INFO        "Schneeberger F. (482)" 

    DESCRIPTION         "Created from : ... ect.pcd V 2.1.30.0" 

    REVISION            "201210170958Z" 

    DESCRIPTION         "NONE" 

    ::= { sbc-ag 20 } 

 

  average-Maximum-Value OBJECT-TYPE 

    SYNTAX       Integer32 

    MAX-ACCESS   read-write 

    STATUS       current 

    DESCRIPTION  "" 

    ::= { regValueInt 3018 } 

  average-Minimum-Value OBJECT-TYPE 

    SYNTAX       Integer32 

    MAX-ACCESS   read-write 

    STATUS       current 

    DESCRIPTION  "" 

    ::= { regValueInt 3019 } 

 

END 

 
 
A ‘log’ file, located in the ‘Doc’ directory of under the device folder of the PG5 project is also 
generated during the build and contains info about the generation of the MIB file. 
 
Note: due to the restriction of the MIB file format, you will see that the most of the symbols will 
get renamed. 
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5.20 FBoxes 
 

5.20.1 S-Bus Communication FBox library 
 
The S-Bus communication library has been extended with the following functions and 
features: 
 

 Transmission of S-Bus telegrams based on event or in cyclical mode 

 New error output for the ‘Send’ and ‘Receive’ FBoxes 

 Labels for inputs and outputs for the ‘Send’ and ‘Receive’ FBoxes. 

 A new help with more information and better navigation options. 
 
Transmission based on event or cyclical mode 
 
The transmission based on event reduces the number of exchanged telegram and 
optimizes the data transfer on Serial S-Bus, Profi-S-Bus or Ether-S-Bus network. 
 

   

 
 
Two new parameters have been introduce into the SASI FBox in order to enable the 
transmission of all ‘Send’ and ‘Receive’ FBoxes related to this channel, in an event base 
mode and/or in a cyclical mode. On the ‘Send’ and ‘Receive’ FBoxes optional parameters 
allows the configuration of the transmission of each individual telegram: 
 
Event based transmission : minimum change of the value that have to be transmitted 
Cyclic transmission according a given time period  
 
Cyclical transmission 
 
Everything works as with the previous version of the library. The old projects are always 
compatible and may be updated to support the events. 
 
Event based transmission 
 

                      
 
All Send telegrams are transmitted in case of modification of one of the input value of the 
FBox. 
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The ‘Dead zone’ can be defined as adjust parameter for each input value of the ‘Send 
Integer’ and ‘Send Float’ FBoxes. 
All telegrams are also sampled with a specific time base. This time base can be defined 
as adjust parameter. 
If necessary, the transmission of telegrams ‘Send’ and ‘Receive’ can be individually forced 
in cyclic mode. 
You will find more information about the event transmission into the FBox library help, 
under the section ‘S-Bus with event transmission’. 
 

                         
 
 
New Error output for ‘Send’ and ‘Receive’ FBoxes 
 
An error output has been defined on each ‘Send’ and ‘Receive’ FBoxes. 
 

                                    
As comparison you will find below the old FBox layout: 
 

                                       
 
This output gets the same status as the LED displayed on the FBoxes. This output can be 
useful in order to check the transmission of specific telegrams. 
 
 
Input and output labels on ‘Send’ and ‘Receive’ FBoxes 
 
The inputs and outputs of ‘Send’ and ‘Receive’ FBoxes have now labels in order to avoid 
confusing the ENABLE input with the value that have to be transmitted.  
The FBoxes of the old projects can always be update with the new interface. Select the 
old FBox then the context menu ‘Update’ 
 
Help 
 
The help has been completed with more details and sections ‘see also’ which help the 
user to find the necessary FBoxes and give useful info for the commissioning. 
 
The S-Bus communication help is now available in English, German, French and Italian. 
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Compatibility of project made with older version of the library 
 
This new version of the S-Bus communication library is fully compatible with older version 
of the library. It means that Fupla program containing older version of the communication 
FBoxes can be build and download without changed. 
 
In order to take advantage of the new functionalities, old project can be updated in going 
through all communication FBoxes and update them using the ‘Update’ command of the 
context menu of the FBox. Then the new adjust parameters and FBox outputs will be 
available. 
 
Note: It is not possible to update only a part of the communication FBoxes; all 
communication FBoxes have to be updated.  
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5.20.2 New Conversion DB n points FBox 

 
A new conversion FBox has been added into the HEAVAC library. 
 

                                    
 
This new FBox converts an input value (X) into an output value (Y) according to a transfer 
function defined with 2 up to n X/Y value pairs stored in a data block (DB). This DB may 
be shared among other FBoxes that use the same transfer function and the values can be 
edited in run-time. The FBox can be stretched up to 24 parallel conversion channels. 
 
This FBox supports the same functionality as the existing “Conversion 20 points” FBox 
with the following advantages:  
 

 Sharing transfer functions (DB) among several FBoxes.  

 Supports predefined transfer functions.  

 Size of the transfer functions freely adjustable according to the requirements.  
 
Transfer function 
 
This is a list of points saved into a DB which describes the relation between the analog 
measure and the physical value, for example when converting a analogue value to a 
temperature value. 
 

 
 
In this sample, for a temperature conversion, the analog measure is X, the temperature is 
Y. 
 
Sharing transfer functions (DB) among several FBoxes 
 
The transfer function is stored into a DB with a number of points between 2 and N pairs of 
values (X, Y).  
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If several “‘Conversion DB N point” FBoxes use the same transfer function, theses 
FBoxes use the same DB too, we edit or adjust the conversion transfer function just one 
time for all the project. 
 
Supports predefined transfer functions  
 
The DB editor dialog supports contains new contexts menus to “Export” and “Import” the 
content of a DB into/from a file format CSV.  
 
So this is no more necessary to edit the content of the DBs, with each new PG5 project.  
Common DBs can be defined and are available for every new project. 
 
We suggest to collect all the transfer functions DBs into the common path ”Symbol Editor” 
closed to the library files. So, the data are easily shared with other projects. 
 
Common path used in Windows 7:  
“C:\Users\Public\Saia-Burgess\PG5_21xxx\Symbol Editor” 
 
Common path used in Windows XP :  
“C\Documents and Settings\All users\Saia-Burgess\PG5_21xxx\Symbol Editor” 
 
Size of the transfer functions freely adjustable according to the requirements  
 
The number of points (X, Y) of the transfer function is defined according the precision of 
the conversion that is required. If we compare with the previous FBox “Conversion 20 
points”, this new conversion FBox is more flexible and can count less than 20 points or 
more. 
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5.20.3 HTTP file transfer library 

 
 
The new HTTP Client Library allows the PCD to act as an HTTP 1.1 client. It means that 
the ‘client’ PCD gets access to the file system of a remote PCD: 
 

 File can be uploaded or downloaded to the remote PCD. 

 DB defined in the client can be copied as file into the remote PCD. 

 DB defined in the client can be updated with the content of a file located in the 
remote PCD. 

 Text defined in the client can be copied as file into the remote PCD. 

 Text defined in the client can be updated with the content of a file located in the 
remote PCD. 

 
 

 
 
 
In the library, the FBoxes are organized based on their functionality: 
 

                                          
 
Communication HTTP 
 
FBoxes for the basis functionality like the data exchange and the diagnostics. 
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File Transfer PCD 
 
FBoxes for the file transfer in order to download files into a remote PCD and upload files 
from a remote the PCD. 
 
Directory Management PCD 
 
FBoxes for the directory management in order to delete files, create, delete and list the 
directories of remote the PCD. 
 
Note: In using this library together with the new ‘Web FTP Server’ function of the Web-
Connect 2.1, it is also possible to exchange files between a PCD and a PC. See the point 
‘Web-Connect version 2.1’ 
 
As the communication is based on HTTP, this library can be used to transfer information 
over Internet and IT infrastructure in an easy way thank the use of the standard HTTP 
protocol.  
 
For more information, please refer to the FBox library help, the documentation and the 
PG5 template projects. 
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5.20.4 S-Monitoring library 

 
The new S-Monitoring FBox library provides access to specific features supported by the 
new metering functionality implemented into some PCD and Energy Manager devices 
(see the point above ‘Monitoring and logging of meter data’ under the ‘Device 
Configurator’ chapter.  
 
This new library provides access to the current and historical data of meters attached to 
PCD controllers or Energy Managers. It handles also custom counters defined at the user 
program level.  
 
This library contains the following type of FBoxes: 
 

 Local counters FBoxes that are used to access features available in firmware of 
supported PCD controllers. 

 

                                          
 

 Remote counters HTTP FBoxes that are used to retrieve data from a remote PCD 
or Energy Manager device using HTTP protocol. 

 

                                      
 
 

 Historical Data HTTP FBoxes that are used to retrieve historical data from local or 
remote PCD controllers or remote Energy Manager devices using HTTP protocol. 
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In order to access historical data and current data of remote PCD, the S-Monitoring FBox 
library uses the HTTP function defined in the HTTP Client library (see point above). 
 
For more information, please refer to the FBox library help, the documentation and the 
PG5 template projects. 
 

5.20.5 IP address to text conversion FBox  

 
A new FBox for the conversion of an IP address to a text has been implemented.  
 

                               
 
This can be used to display IP address in text terminal or when sending email. 
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5.21 FBox Builder 
 

5.21.1 Language dependent default and init value 
 
For the adjust values which contain text, the init and default value can be defined 
depending on the language.   
 

                               
 
To specify the value just open the Adjust window and for the Types of content of text the 
fields are language dependent and will be displayed in the ‘Language Editor’ dialog, under 
the ‘FBoxes’ tab. 
 

5.21.2 Initialization values for Text and DB predefined static symbols 
 
As texts and DBs are more and more often used in FBoxes, it became necessary to 
define their initialization value and size together with their definition. It is also language 
dependent as the symbol name, and the size and init value can be similarly defined as in 
the PG5 Symbol Editor. 
 

 
 
 
The format is:              <symbolname> [<size>] := <init value> 
 
The init value for texts is defined like this: “<text content>”. 
The init values for DBs are items values, separated by comma. 
 
Both size and init value are optional. 
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5.21.3 Library options 

 
General options that are library dependent have been moved to the library level. It means 
that ‘Disable Syntax Checking’, ‘Detailed Adjust Help’ and ‘Start Help Compilation after 
Build’ can be defined for each library, in using the ‘Properties …’ command under the 
‘Library’ menu. Default values of those options can be defined for new libraries in the 
‘Option’ dialog, available with the ‘Options …’ command under the ‘Tools’ menu. 
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5.21.4 Improvements in the link between the FBoxes and the help 

 
Help topics for the FBoxes generated by the FBox Builder are now displayed based on 
the name of the macro. It means that in case of FBox having the same name in two 
different libraries, the help will be called correctly. This mechanism is now used for all 
helps written into FBox Builder.  
 
It is also possible to define the help topics manually, when the help is generated by an 
external tool. For library and family, the topic can be entered in the ‘Help’ tab of the 
‘Properties’ dialog (see picture above). For FBoxes, it can be defined in the ‘Help’ tab of 
the workspace (see picture below).   
 
 

 
 

5.22 Creating FB libraries 
 

From PG5 version 2.0, the Instruction List Editor contains a ‘Function Selector’ window. This 
shows a list of all installed Function Block (FB) and System Function (SF) libraries. From the 
selector window it is easy to insert function calls into your IL code using drag and drop or 
double-click.  
 

                      
 
A detailed step-by-step description now exists to help creating and adding your own Function 
Block libraries and make them available inside the ‘Function Selector’ window. See the 
Project Manager's help, ‘How to create an FB Library’, in the ‘How to…’ section. 
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5.23 Saia.Net Web-Connet Version 2.1 
 

An updated version of Saia.Net Web-Connect has been integrated in the PG5 2.1. This new 
version contains the following new functionalities: Reverse HTTP, Mail interface, Web FTP 
server and Web FTP. 
 
Beside those new functionalities, the configuration interface, based on the web, has been 
updated in order to run under the standard web browser. In the following, you will find a short 
description about each new component. For more information, please refer to the help of the 
Saia.Net Web-Connect 2.1 

5.23.1 New configuration interface 

 
The configuration interface of the Web-Connect 2.1 has been completely re-written. This 
configuration interface allows the configuration of the Web-Connect communication and 
the configuration of the new functionalities described in the following points. 
 

 
 
The configuration works with the most common browser: Internet Explorer (from version 
8), Firefox and Chrome. The look and feel of the configuration is a bit different, but the 
functionality and the parameters are the same as in the precedent version. 
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5.23.2 Reverse HTTP – Portal application 

 
WAC PCDs are equipped with a GPRS modem with which a PCD can connect itself to the 
Internet. When a WAC establishes a network connection over GPRS the provider will 
assign an IP address to the PCD.  Usually this address is in a private network. A private 
address will allow the PCD to communicate with the whole internet but it is currently 
impossible to access the PCD from the Internet.  
 
The main goal of this function is to work around this limitation in order to allow external 
access to the PCD’s web server.  
 

              
 
Functional principle: 
 

 The WAC establishes a connection to the Reverse Server (green arrow).  

 Client sends an HTTP request to a Web-Connect station representing one of the 
WACs. 

 Web-Connect forward the request over the Http Reverse channel to the WAC. 
 
Accessing a PCD over a Reverse HTTP channel is transparent for the client. The client 
can access a WAC like any other Web-Connect station. 
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The configuration of the Reverse HTTP Server is done using the web interface, under the 
‘Settings’ view, in the ‘Reverse HTTP Server’ tab. 
 

 
 
For the configuration of the PCD, the Device Configurator has to be used. The settings 
are located in the ‘HTTP Portal’ slot under the Ethernet Protocols slot category. 
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5.23.3 Mail Interface 

 
The Mail File Gateway allows saving files sent as an email attachment by a PCD.  
The PCD sends an email with an attached file and the destination directory on the Web-
Connect PC using its SMTP client functionality. The mail is received and stored by a mail 
server.  
 
The new Mail File Gateway plug-in of Web-Connect is periodically checking the mail 
server for new mails. Once a mail is present it downloads it and saves the attachment to 
the directory specified in the mail. 
Clients can then access the saved files over the usual HTTP requests. 
 

      
The mail interface function can be configured using the web interface, under the ‘Settings’ 
view, in the ‘Mail Interface’ tab. 
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5.23.4 Web FTP Server 

 
With the new HTTP File Transfer library - see point FBoxes / HTTP File Transfer library, it 
is now possible to transfer files between PCDs, in using the standard HTTP protocol. 
 
In order to transfer files from PCD to PC, a new function has been integrated into Web-
Connect: the Web FTP Server. The Web FTP Server handles the HTTP commands sent 
by the PCD client using the specific FBoxes and gives access to specified directories, in 
order to read and write files. 
 
The possible applications are:  
 

 Transfer log files from PCD into the PC. 

 The PCD loads a recipe file defined in a PC. 
       

 
 
The configuration is quiet easy and doesn’t need a lot of parameters; you only have to 
defined the root directory under the ‘Web FTP Server’ tab and define the access right 
under the ‘Account Manager’ tab. 
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5.23.5 Web FTP 

 
The new Web FTP functionality allows accessing the file system of the connected station 
directly from the Web Connect.  
 

 
 
It gives an easy way to manage the file stored in the PCD file system directly from your 
standard web browser interface, without having to start an external FTP client application. 
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